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Capabilities
Features
Outbound Option enables call centers to manage outbound calls. With Outbound Option, you can configure
a contact center to automatically dial customer contacts from imported lists and direct a call to an available
agent. This application transfers a call to an agent only if a live contact is reached.
A summary of major features in Outbound Option follows:
Automated dialing
The dialer automatically dials contact numbers, screens for busy signals, no answers, and answering
machines, and transfers calls to agents. The dialer transfers a call to an available agent only when it
reaches a live contact.
Campaigns
Users create calling campaigns using a set of tabs in a graphical user interface (GUI). A campaign is a
filtered set of numbers that will be automatically dialed and a set of agents who will talk to contacted
customers.
More specifically, a campaign consists of imported contact lists, query rules that filter the contact list to
create a dialing list, and agent skill groups.
Imported contact lists and Do Not Call lists
You can import lists of customers you want to call and lists of customers who you do not want to call.
You can configure Outbound Option to import both types of lists either by continuously polling or at
scheduled intervals. You can also specify whether imported lists will replace existing lists or be appended
to them.
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Query rules
Query rules define a set of criteria to filter contact lists. In this way, you can define specific dialing lists
for campaigns. A campaign can have multiple query rules, but only one query rule and resulting dialing
list is active at a time.
Agent skill groups
You assign agents to campaigns by using skill groups. A skill group defines a set of agents with specific
capabilities, such as language skills, product knowledge, or training that is associated with a campaign.
Agents might belong to multiple skill groups and thus be part of multiple campaigns.
Campaign management
Outbound Option uses a dialing list that is associated with the active query rule in a campaign and directs
dialers to place calls to customers. The dialer then directs contacted customers to agents. Advanced
campaign-management features provide flexibility in campaign configurations. You can do the following:
• Assign customer records to multiple lists.
• Merge lists into a single campaign.
• Configure rules that define when the various lists are called. Only one rule is active at a time but
you can set up multiple rules and switch among them.
• Assign agents to campaigns using skill groups.
Dedicated or Blended modes
You can specify either of the following modes for agents:
• Dedicated mode is designed for agents who make only outbound calls.
• Blended mode allows agents to receive inbound calls and make outbound calls without switching
between skill groups. In this mode, inbound calls receive precedence.
Choice of dialing modes
Outbound Option supports the following dialing modes:
• Preview mode lets the agent preview the contact information on the desktop and decide whether
the SIP dialer should dial a contact.
• Direct Preview mode is similar to Preview mode; however, the dialer places the calls from the
agent's phone. This mode prevents abandoned calls and false positive detection of answering
machines.
• Progressive mode dials a configured number of calls per available agent.
• Predictive mode adjusts the number of calls dialed per agent based on the current abandon rate.
Callbacks
If a customer requests a callback for a later date and time, the agent can enter the request in the system,
and the dialer schedules the call appropriately. The following callback types are supported:
• Personal callbacks specify that the customer receive a callback from the same agent who made the
initial contact.
• Regular callbacks are handled by any available agent.
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Call analysis
The Call Progress Analysis (CPA) feature uses a combination of call signaling and media stream analysis
to identify different types of calls, such as faxes and modems, answering machines, and operator intercepts.
Sequential dialing
The sequential dialing feature allows up to ten phone numbers per customer record.
Abandoned and retry calls
You can configure campaigns to retry abandoned calls.
Campaign prefix digits for dialed numbers
You can configure a prefix for customer number, which can be used to identify specific campaigns.
Activity reports
Outbound Option reporting features include agent, campaign, dialer, and skill groups report templates.
Two-Way Replication
If you choose to enable Outbound Option, you can also enable Outbound Option High Availability.
Outbound Option High Availability supports two-way replication between the Outbound Option database
on Logger Side A and the Outbound Option database on Logger Side B.

Outbound API
Outbound API allows you to use REST APIs to create, modify, and delete Outbound Option campaigns.
Outbound API provides a streamlined mechanism for creating campaigns with a single preconfigured query
rule and import rule. As such, if you use the API to create a campaign, that campaign is not available in the
Outbound Option Campaign Configuration tool. If a campaign was created with the API, you must use the
API to view, edit, or delete it. If a campaign was created with the Outbound Option Campaign Configuration
tool, you must use that tool to view, edit, or delete it.
Administrative scripts are not required for Outbound Option campaigns created with the Outbound API. If
an administrative script is provided, the information in the script overrides the information defined in the API.
Outbound API consists of the following APIs:
• Outbound Campaign API: Use this API to define new Outbound Option campaigns, and to view, edit,
or delete existing campaigns. You can also use this API to disable all campaigns at once (emergency
stop).
• Do Not Call API: Use this API to set the Do Not Call (DNC) import rule configuration for Outbound
Option. This prevents the Dialer from dialing the numbers on the DNC list.
• Import API: Use this API to import customer contact information for an Outbound Option campaign.
• Time Zone API: Use this API to list all available time zones and to get information for a specified time
zone. You also use this API with the Outbound Campaign API to set the default time zone for an Outbound
Option campaign.
• Campaign Status API: Use this API to get the real-time status of running Outbound Option campaigns.
• Personal Callback (PCB) API: Use this API to configure your Outbound Option campaign to handle
personal callbacks. You can create personal callback records individually or in bulk. You can also use
this API to update or delete personal callback records.
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For more information about Outbound API, see the Cisco Packaged Contact Center Enterprise Developer
Reference Guide at https://developer.cisco.com/site/packaged-contact-center/documentation/.

Dialing Modes
Outbound Option supports various dialing modes, described in the following sections.

Note

All dialing modes reserve an agent at the beginning of every Outbound Option call cycle by sending a
reservation call to the agent.

Predictive Dialing
In predictive dialing, the dialer determines the number of customers to dial per agent based on the number of
lines available per agent and the configured maximum abandon rate. The agent must take the call if that agent
is logged in to a campaign skill group.
A Predictive Dialer is designed to increase the resource utilization in a call center. It is designed to dial several
customers per agent. After reaching a live contact, the Predictive Dialer transfers the customer to a live agent
along with a screen pop to the agent’s desktop. The Predictive Dialer determines the number of lines to dial
per available agent based on the target abandoned percentage.
Outbound Option predictive dialing works by keeping outbound dialing at a level where the abandon rate is
below the maximum allowed abandon rate. Each campaign is configured with a maximum allowed abandon
rate. In Predictive mode, the dialer continuously increments the number of lines it dials per agent until the
abandon rate approaches the configured maximum abandon rate. The dialer lowers the lines per agent until
the abandon rate goes below the configured maximum. In this way, the dialer stays just below the configured
maximum abandon rate. Under ideal circumstances, the dialer internally targets an abandon rate of 85% of
the configured maximum abandon rate. Due to the random nature of outbound dialing, the actual attainable
abandon rate at any point in time may vary for your dialer.

Preview Dialing
Preview dialing reserves an agent before initiating an outbound call and presents the agent with a popup
window. The agent can then Accept or Reject the call with the following results:
• Accept: The customer is dialed and transferred to the agent.
• Reject: The agent is released. The system then delivers another call to the agent, either another Preview
outbound call, or a new inbound call.
• Rejects-Close: The agent is released and the record is closed so it is not called again. The system then
delivers another call to the agent, either another Preview outbound call or a new inbound call.

Direct Preview Dialing
The Direct Preview mode is similar to the Preview mode, except that the dialer automatically places the call
from the agent's phone after the agent accepts. Because the call is initiated from the agent's phone, the agent
hears the ringing, and there is no delay when the customer answers. However, in this mode, the agent must
deal with answering machines and other results that the Dialer Call Progress Analysis (CPA) handles for other
campaign dialing modes.
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Note

• The CPA feature is not available while using Direct Preview Dialing mode.
• A zip tone is a tone that announces incoming calls. There is no zip tone in Direct Preview mode.

Progressive Dialing
Progressive Dialing is similar to predictive dialing (see Predictive Dialing, on page 4). The only difference
is that in Progressive Dialing mode, Outbound Option does not calculate the number of lines to dial per agent,
but allows users to configure a fixed number of lines that will always be dialed per available agent.

Note

In the Outbound dialer log, the Progressive dialing mode is also logged as Predictive.

Initial Setup and Maintenance
This section is intended for system administrators who install and configure Packaged CCE. It describes the
one-time tasks required to set up Outbound Option. It also discusses occasional upgrade and maintenance
tasks. It contains the following topics:
• Outbound SIP Dialer Call Flows, on page 5
• Initial Setup Task Lists, on page 8
• Unified CCE Configuration for Outbound Option, on page 8
• Unified Communications Manager and Gateway Configuration, on page 10
• Outbound Option Software Installation Steps, on page 16
• Maintenance Considerations, on page 27

Outbound SIP Dialer Call Flows
Call Flow Diagram for Packaged CCE
This figure illustrates a transfer to agent call flow for a SIP dialer Outbound Option campaign.
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Figure 1: SIP Dialer Agent Campaign Call Flow

The call flow works as follows:
1.

You schedule the import and the campaign starts. Records are delivered to the dialer.

2.

The dialer looks for an available agent through the media routing interface.

3.

The media routing peripheral gateway (MR PG) forwards the request to the router.

4.

The routing script identifies an agent and responds to the MR PG.

5.

The MR peripheral interface manager (PIM) notifies the dialer that the agent is reserved.

6.

The dialer signals the gateway to call the customer.

7.

The gateway calls the customer and notifies the dialer of the attempted call.

8.

Call Progress Analysis (CPA) is done at the gateway. When voice is detected, the gateway notifies the
dialer.

9.

The dialer directs the voice gateway to transfer the call to the reserved agent by the agent extension.

10.

The gateway directs the call to the agent through Unified Communications Manager (using dial peer
configuration to locate the Unified Communications Manager). Media are set up between the gateway
and the agent's phone.

Unattended VRU Call Flow Diagram for Packaged CCE
This figure illustrates a transfer-to-VRU call flow for a SIP dialer Outbound Option campaign.
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Figure 2: SIP Dialer Unattended IVR Campaign Call Flow

The call flow works as follows:
1.

An unattended VRU campaign starts and schedules an import. Records are delivered to the dialer.

2.

The dialer sends a SIP INVITE to the voice gateway to call a customer.

3.

The gateway calls the customer.

4.

Call Progress Analysis (CPA) detects an answering machine (AMD) and notifies the dialer.

5.

The dialer sends a VRU route request to the MR PG.

6.

The MR PG forwards the route request to the router which invokes the routing script.

7.

The router sends the route response with the network VRU label to the MR PG.

8.

The MR PG forwards the route response to the dialer.

9.

The dialer sends a SIP REFER request for the label to the voice gateway.

10.

The voice gateway transfers the call to Unified CVP.

Unified CVP then takes control of the call.
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Initial Setup Task Lists
This section includes summary lists of all tasks for Outbound Option initial setup.

System Configuration for Outbound Option
The first phase is to configure Outbound Option to handle the optional Outbound Option components.
Table 1: Configure Packaged CCE for Outbound Option

Step Number

See the topic that describes

1

How to configure the Dialer component.

2

How to configure the Port map for each dialer.

3

How to configure System Options.

4

How to enable ECC variables.

5

Packet capture.

6

Voice Gateway configuration.

7

How to create the Outbound Option private database.

Unified CCE Configuration for Outbound Option
This section provides procedures for configuring Unified CCE for Outbound Option.

Configure the Dialer Component
You deploy the Dialer as a single redundant pair for each Agent PG with agents who handle Outbound Option
calls.
Procedure

Step 1

Make sure that all Packaged CCE services are running.

Step 2

In the Unified CCE Configuration Manager, expand Outbound Option Option and double-click Dialer
to display the Outbound Option Option Dialer configuration window.

Step 3

Click Retrieve.

Step 4

Click Add to add a new dialer.

Step 5

Enter the required information on the Dialer General Tab. See the Configuration Manager Online Help for
details of these fields.

Step 6

Click Save.

Step 7

Select the Port Map Selection tab to display the port map configuration. See the Configuration Manager
Online Help for details of configuring these mappings.

Step 8

Click Add

Step 9

Configure a set of ports and their associated extensions.
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A Dialer can support 1500 ports. The allowed Telephony Port range is from 0 to 1499.
Step 10

Click OK. The port mappings appear on the Port Map Selection tab.

Step 11

Click Save to save all the configuration information.

Configure System Options
Procedure

Step 1

In Unified CCE Configuration Manager, expand Outbound Option, and then select System Options.

Step 2

Click the General Options tab and define the dialing time range to use for all your Outbound Option campaigns,
and then click OK.

What to do next

Note

If you have previously configured campaigns, you can update them now. Click the Bulk Update tab page
and define specific dialing time ranges for phone numbers, and then click Update All Campaigns.

Enable Expanded Call Context Variables
Perform the following steps to enable the expanded call context variables.
Procedure

Step 1

In Unified CCE Administration, click Manage > Expanded Call Variables.

Step 2

Enable all BAxxxx variables (BAAccountNumber, BABuddyName, BACampaign, BADialedListID,
BAResponse, BAStatus, and BATimezone).

What to do next
By default, the solution includes the predefined BAxxxx ECC variables in the "Default" ECC payload. You
can also create a custom ECC payload for your Outbound Option call flows. Always remember that you cannot
use an ECC variable unless it exists in one of the ECC payloads that you use for a call flow.

Packet Capture for Troubleshooting
For the SIP Dialer to capture data, ensure that the dialer on the Unified CCE PG machine uses the active
interface from the Ethernet Interface list. You can determine the active interface with a network protocol
analyzer tool such as Wireshark, which you can download from www.wireshark.org. The interface with
network packets is the active interface.
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You can change the SIP Dialer packet capture parameters to use the active interface from the Windows Registry
Editor. Change the interface name option (-i) in the CaptureOptions key to the number of the active
interface. For example, to use the third interface, set the value for -i to -i 3.
Capture files are in the HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customer
instance>\Dialer registry key location.

Unified Communications Manager and Gateway Configuration
In the next phase of Outbound Option installation, you set up Unified Communications Manager and its related
gateway.
The following table lists the steps that comprise Unified CM setup.
Table 2: Unified CM Configuration Steps for Deployments with SIP Dialer

Step Number

Procedure

1

Disable Ringback During Transfer to Agent for SIP, on page 10

2

Configuration of Voice Gateways, on page 12

3

Configure SIP Trunks, on page 15

Disable Ringback During Transfer to Agent for SIP
The voice gateway generates a ringback tone to the customer. To prevent the gateway from generating a
ringback, apply a SIP normalization script to the Unified Communications Manager SIP trunk.
Apply this SIP normalization script only to the SIP trunk that handles the inbound call from the voice gateway
for agent transfer.
• If your deployment uses the same gateway for both PSTN calls and the dialer, complete all steps, 1 to
13, to create a dedicated SIP trunk and apply the normalization script.

Note

The trunk for PSTN calls still needs a 180 RINGING SIP message for inbound
calls to trigger the gateway to play ringback to the PSTN.
For more information, see the TechNote Disable Ringback During Transfer to
Agent for SIP at https://www.cisco.com/c/en/us/support/docs/
customer-collaboration/packaged-contact-center-enterprise/
200323-Cisco-Packaged-Contact-Center-Enterprise.html.

• If your deployment has a dedicated SIP trunk to handle the agent transfer dialer, complete steps 1 to 2
and 8 to 13 to apply the normalization script to your SIP trunk.
Procedure

Step 1

Navigate to https://<IP_address>:8443 where <IP_address> identifies the Unified
Communications Manager server.
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Step 2

Sign in to Unified Communications Manager.

Step 3

To create a SIP trunk security profile in Unified Communications Manager, select Communications Manager
GUI > System > Security > SIP Trunk Security Profile > [Add New].
The default port is 5060.
Figure 3: SIP Security Profile

Step 4

Click Save.

Step 5

Create a new SIP trunk and add the new SIP Trunk Security Profile.
Figure 4: Create a New SIP Trunk

Step 6

Click Save.

Step 7

Click Reset.

Step 8

In Communications Manager GUI > Devices > Device Settings > SIP Normalization Scripts > [Create
New], enter the following SIP normalization script into the content field. All other values remain set to default.
M = {}
function M.outbound_180_INVITE(msg)
msg:setResponseCode(183, "Session in Progress")
end
return M
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Figure 5: Add Normalization Script

Step 9

Click Save.

Step 10

Associate the new normalization script with the SIP trunk.
Figure 6: Associate Script with Trunk

Step 11

Click Save.

Step 12

Click Reset.

Configuration of Voice Gateways
Telecom carriers sometimes send an ISDN alerting message without a progress indicator. This situation causes
the voice gateway to send a SIP 180 Ringing message, instead of a SIP 183 Session In Progress message, to
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the SIP dialer. The SIP dialer can process provisional messages such as 180, 181, 182, and 183 with or without
Session Description Protocol (SDP). When the SIP dialer receives these provisional messages without SDP,
the dialer does not perform Call Progress Analysis (CPA) and the Record CPA feature is disabled.
To enable the SIP dialer to perform CPA, add the following configuration to the POTS dial-peer of the voice
gateway: "progress_ind alert enable 8". This code sends a SIP 183 message to the SIP dialer.
Telecom carriers sometimes send an ISDN alerting message without a progress indicator. This situation causes
the voice gateway to send a SIP 180 Ringing message, instead of a SIP 183 Session In Progress message, to
the SIP dialer. The SIP dialer can process provisional messages such as 180, 181, 182, and 183 with or without
Session Description Protocol (SDP). The SIP Dialer processes the CPA information along with the SDP
information because the SDP information is part of these provisional messages. But if the dialer receives these
provisional messages without SDP, the dialer does not perform Call Progress Analysis (CPA) and the Record
CPA feature is disabled. If the next provisional message changes the SDP information, the dialer processes
the SDP information.
Enable 100rel for Outbound Option. Otherwise, Outbound calls from the SIP Dialer fail. The following two
sections provide examples of voice gateway configuration from the command line.
Configure Rel1xx Supported for Dial-Peer for the SIP Dialer
The following example shows how to enable rel1xx on a voice dial-peer for the SIP dialer. It uses 8989 for
the tag of the voice dial-peer.
GW(config)#config t
GW(config-dial-peer)#dial-peer voice 8989 voip
GW(config-dial-peer)#voice-class sip rel1xx supported 100rel
GW(config-dial-peer)#exit
GW(config)#exit
GW#wr

This short procedure results in the following dial-peer configuration. (Only the bolded line is relevant to this
discussion.)
dial-peer voice 8989 voip
incoming called-number 978T
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte h245-signal h245-alphanumeric
codec g711ulaw

Configure Outgoing Dial-Peer for a Dialing Customer
The following example shows how to configure an outgoing dial-peer for a dialing customer.
GW(config)#config t
GW(config-dial-peer)#dial-peer voice 97810 voip
GW(config-dial-peer)#destination-pattern 97810[1-9]
GW(config-dial-peer)#port 1/0:23
GW(config-dial-peer)#forward-digits all
GW(config-dial-peer)#exit
GW(config)#exit
GW#wr

This short procedure results in the following dial-peer configuration for a dialing customer.
dial-peer voice 97810 pots
destination-pattern 97810[1-9]
port 1/0:23
forward-digits all
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Configure Rel1xx Disable for Unified CVP Voice Dial-Peer
The following example shows how to disable rel1xx for a Unified CVP voice dial-peer. It uses 8989 for the
tag of the voice dial-peer.
GW(config)#config t
GW(config-dial-peer)#dial-peer voice 8989 voip
GW(config-dial-peer)#voice-class sip rel1xx disable
GW(config-dial-peer)#exit
GW(config)#exit
GW#wr

This short procedure results in the following dial-peer configuration. (Only the bolded line is relevant to this
discussion.)
dial-peer voice 8989 voip
description CVP SIP ringtone dial-peer
service ringtone
incoming called-number 9191T
voice-class sip rel1xx disable
dtmf-relay rtp-nte h245-signal h245-alphanumeric
codec g711ulaw
no vad

Configure an Outgoing Dial-Peer for Transferring Call to Agent
The following example shows the outgoing dial-peer configuration for transferring calls to agents.
dial-peer voice 11000 voip
destination-pattern 11T
session protocol sipv2
session target ipv4:10.10.10.31(this is Call Manager's IP address)
voice-class codec 1
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte h245-signal h245-alphanumeric
no vad

Note

In a SIP Dialer with Unified CVP VRU deployment, dialer-related call flows do not invoke call-survivability
scripts that are enabled on an incoming POTS dial-peer in the Ingress gateway. However, enabling a
call-survivability script on an Inbound POTS dial-peer does not negatively affect dialer-related call flows.

Configure Transcoding Profile for Cisco Unified Border Element
The following example shows the transcoding profile for Cisco UBE.

Note

Transcoding impacts port density.

dspfarm profile 4 transcode universal
codec g729r8
codec g711ulaw
codec g711alaw
codec g729ar8
codec g729abr8
maximum sessions 250
associate application CUBE
!
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Outbound Gateways and Packaged CCE System Inventory
Configure Outbound Gateways in the Unified CVP OAMP to allow them to appear in the Packaged CCE
inventory on the System Deployment tool.

Configure Cisco Unified Border Element
While configuring Cisco UBE, ensure that you:
• Configure the three dial-peers in the Cisco UBE.
The dial-peers are used for:
• Incoming calls from the dialer.
• Outgoing calls to the terminating network from the Cisco UBE.
• Calls to be routed to the Cisco Unified Communications Manager.
• Issue the following commands globally to configure the Cisco UBE:
• no supplementary-service sip refer
• supplementary-service media-renegotiate

Note

Virtual CUBE does not support CPA. Use a dedicated physical gateway if your solution needs CPA.

Configure SIP Trunks
Unified CM is connected to the voice gateway by SIP Trunks, which you configure on Unified CM. Set up
route patterns for the Dialer which are appropriate for your dial pattern.
See the System Configuration Guide for Cisco Unified Communications Manager at https://www.cisco.com/
c/en/us/support/unified-communications/unified-communications-manager-callmanager/
products-installation-and-configuration-guides-list.html for instructions on how to configure SIP trunks. For
information about logging in to Ingress or VXML gateways, refer to the sections on configuring gateways
for Courtesy Callback in the Configuration Guide for Cisco Unified Customer Voice Portal at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/
products-installation-and-configuration-guides-list.html.
Procedure

Configure a SIP trunk on Unified CM from Unified CM to the voice gateway. Specify the IP address of the
voice gateway in the Destination field.
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Configure E1 R2 Signaling
The Outbound Option Dialer may be configured with systems using the E1 R2 signaling protocol. E1 R2
signaling is a channel associated signaling (CAS) international standard that is used with E1 networks in
Europe, Latin America, Australia, and Asia. For more information, see E1 R2 Signaling Theory
The high-level procedure for configuring an E1 R2 controller for use with the Outbound dialer is summarized
below. For full configuration details, see E1 R2 Signaling Configuration and Troubleshooting.
Procedure

Step 1

Set up an E1 controller connected to the private automatic branch exchange (PBX) or switch. Ensure that the
framing and linecoding of the E1 are properly set for your environment.

Step 2

For E1 framing, choose either CRC or non-CRC.

Step 3

For E1 linecoding, choose either HDB3 or AMI.

Step 4

For the E1 clock source, choose either internal or line. Keep in mind that different PBX's may have different
requirements for their clock source.

Step 5

Configure line signaling.

Step 6

Configure interregister signaling.

Step 7

Customize the configuration with the cas-custom command.

Example E1 R2 Settings
controller E1 0/0/0
framing NO-CRC4
ds0-group 1 timeslots 1-15,17-31 type r2-digital r2-compelled ani
cas-custom 1
country telmex
category 2
answer-signal group-b 1
caller-digits 4
dnis-digits min 4 max 13
dnis-complete
timer interdigit incoming 1000
groupa-callerid-end

Outbound Option Software Installation Steps
This section discusses the tasks that are associated with installing Outbound Option and related components.
Before proceeding, navigate to the Side A Unified CCE AW-HDS-DDS and stop all ICM services there. Then
perform the steps in the following sections.

Software and Database Creation
In the next phase, you install the Outbound Option component software and create its database. The following
table lists the steps that comprise software installation and database creation.
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Table 3: Software Installation and Database Creation Steps

Step

Procedure

1

Configure the Logger for Outbound Option, on page 21

2

Create Outbound Option Database, on page 20

3

Add MR PIM for Outbound, on page 24

4

Install Dialer Component on the PG Virtual Machine, on page 24

Outbound Option Database
Outbound Option uses a dedicated SQL database on the Logger. The installation includes creating this database.
The installer collects some business-related data to properly create the database.
If you enable Outbound Option High Availability, ensure that the Logger virtual machine datastore is large
enough to accommodate both the Logger database and the Outbound Option database on Logger Side A and
Logger Side B. Also ensure that the Outbound Option database disk drive is sized sufficiently to handle the
distribution database.

Note

When using Outbound Option High Availability on a Packaged CCE system, the maximum number of records
that can be imported without adding any extra disk space to the Rogger VM is one million.

Outbound Option for High Availability: Preliminary Two-Way Replication Requirements
If you plan to set up Outbound Option for High Availability two-way replication, there are several preliminary
requirements.
Assign Privileges to Select Users
You must:
• Create a Microsoft SQL Server user and assign that user the sysadmin privilege. The username and
password must be the same on Logger Side A and Logger Side B. (You use this username and password
when you run Web Setup to configure Outbound Option and enable Outbound Option High Availability).
• Assign the sysadmin privilege to the NT authority/System user.
Verify Replication Feature Selected During Microsoft SQL Server Installation
If you intend to use Outbound Option High Availability Replication, you must select Replication as a feature
when you install Microsoft SQL Server. To confirm the selection of the Replication feature:
1. From the Microsoft SQL Server installation disk, run setup.exe.
2. Select Tools, and click Installed SQL Server Discovery Report.
3. Confirm that the Replication feature is listed. If the feature is not listed, run the following command:
setup.exe /q /Features=Replication /InstanceName=<instancename> /ACTION=INSTALL
/IAcceptSQLServerLicenseTerms
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in which you enter the applicable instance name for your Microsoft SQL Server installation as the
<Instance Name>.
Create an Outbound Option Database on Logger Side A and Side B
If you have enabled Outbound Option on Logger Side A in a previous release, you must:
• Stop all Logger services on Logger Side A.
• Perform a full database backup for the Outbound Option database on Logger Side A and restore it to
Logger Side B. Use SQL Server Management Studio (SSMS) to complete this task.
If you have not enabled Outbound Option in a previous release, you must create an Outbound Option database
on Logger Side A and Logger Side B. Use the ICMDBA utility to complete this task.

Note

If the database replication fails and it is resolved, the Outbound Option HA must be enabled again. In such a
case, you must again synchronize the databases on the Active and Standby sides. Perform a full database
backup for the Outbound Option database on Active side and restore it to the Standby side.

Define Logger Public Interface Hostname on Logger Side A and Logger Side B
As you configure Outbound Option for High Availability, you must define the Logger Public Interface
Hostname on both sides of the Logger. IP addresses are not allowed.
Make Campaign Manager and Dialer Registry Setting Customizations on Both Side A and Side B
If you customize any Campaign Manager and Dialer registry settings on one side, you must make the same
updates for the registry settings on the other side.
Stop the Logger Service Before Enabling or Disabling Outbound Option High Availability
Before you enable or disable Outbound Option High Availability, stop the Logger service on the applicable
side or sides.

Two-Way Replication Performance
By default, Outbound Option High Availability uses default replication performance parameters. In most
cases, these default parameters produce acceptable performance results.
Microsoft SQL Server Replication, however, allows tuning of these parameters, which may, in some cases,
improve performance:
• Log Reader parameters.
• Distribution Agent parameter.
Tune Log Reader Parameters
The Log Reader Agent and Distribution Agent support batch sizes for transaction read and commit operations.
Batch sizes default to 500 transactions.
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The Log Reader Agent reads the specific number of transactions from the log. You can increase this parameter
to up to 10,000 transactions.
The -PollingInterval parameter specifies how often the transaction log of a published database is queried for
transactions to replicate. The default is five seconds. If you decrease this value, the log is polled more frequently.
More frequent polling can result in lower latency for the delivery of transactions from the publication database
to the distribution database.
Tune the Log Reader job parameters by following these steps.
Procedure

Step 1

Locate the Log Reader job in SQL Server Management Studio, under SQL Server Agent jobs. The title of the
job is <Publisher Name>-<instance name>_baA-N.

Step 2

Right-click on the job and select Properties; the job Property page appears.

Step 3

Select the Steps page, and double-click the Run Agent step.

Step 4

In the command window, position the cursor at the end of the command and add the desired parameters.
For example, you can:
• Increase the value of the -ReadBatchSize parameter for the Log Reader Agent. To set the read batch size
to 10,000, for example, set -ReadBatchSize 10000.
• Decrease the value of the -PollingInterval parameter for the Log Reader Agent. To set the polling interval
to one second, for example, set -PollingInterval 1.

Tune Distribution Agent Parameter
The Distribution Agent and Log Reader Agent support batch sizes for transaction commit and read operations.
Batch sizes default to 500 transactions.
Committing a set of transactions has a fixed overhead. The overhead is spread across a larger volume of data.
This parameter defaults to 500 but can be increased to 10,000, by committing a larger number of transactions
less frequently.
Tune the Distribution Agent job parameter by following these steps.
Procedure

Step 1

Locate the Distribution Agent job in SQL Server Management Studio, under SQL Server Agent jobs. The
title of the job is <Publisher Name>-<instance name> PubBA-<Subscriber>-N.

Step 2

Right-click on the job and select Properties; the job Property page appears.

Step 3

Select the Steps page, and double-click the Run Agent step.

Step 4

In the command window, position the cursor at the end of the command and add the desired parameter.
To increase the value of the -CommitBatchSize parameter for the Distribution Agent to 10,000, for example,
set -CommitBatchSize 10000.
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Create Outbound Option Database
Before you use Outbound Option, estimate the size for the Outbound Option database.
If you want to use Outbound Option in duplex mode with High Availability and configure two-way replication,
keep in mind that replication often requires a larger size due to the distribution database storage. Please plan
accordingly. Then, perform the following steps to create the database on the Logger Side A platform and the
Logger Side B platform with the ICMDBA utility.
Procedure

Step 1

Collect the following information:
• The size, in bytes, of each customer record in the import file. If the size is less than 128 bytes, use 128.
(RecordSize)
• The number of records that are imported. (RecordCount)
• Do the records from new imports replace or append to records that are already in the database?

Step 2

Estimate the contact table size as follows:
• If imports overwrite existing records: Do not change record count.
• If imports append to existing records: RecordCount = total number of rows kept in a customer table at
a time.
• contact-table-size = RecordSize * RecordCount * 1.18

Step 3

Estimate the dialing list table size as follows:
• If imports overwrite existing records: RecordCount = number of rows imported * 1.5. (50% more rows
are inserted into the dialing list than are imported.)
• If imports append existing records: RecordCount = total number of rows kept in customer table at a time
* 1.5
• dialing-list-table-size = rows in dialing list * 128 bytes * 4.63

Step 4

Calculate the database size using this formula:
(Number of rows in all DL tables * (size of one row + size of index) ) +
(Number of rows in personal call back table * (size of one row + size of index) ) +
(Number of rows in Contact List table * (size of one row + size of index))

Step 5

Start ICMDBA by entering ICMDBA in the Microsoft Windows Run dialog box or command window.

Step 6

Select the Logger. Then, select Database > Create.

Step 7

In the Create Database window, specify the Outbound Option database type.

Step 8

Click Add. The Add Device window appears.
Use this window to create a new data device and log device for the Outbound Option database. Specify the
disk drive letter and size in megabytes for each new device.

Step 9

Click OK to create the device.

Step 10

Click Create, and then click Start.
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Step 11

Click Close.

If necessary, you can later edit the device to change storage size, or remove a device, using the Database >
Expand option.

Caution

You cannot make manual changes to the contents of the Outbound Option database. Do not use triggers in
the Outbound Option database. Do not add or modify triggers for the dialing lists or personal callback list.
The Dialer_Detail table in the logger or HDS contains the information that custom applications require. Extract
that information from the historical database server (HDS) to a separate server where the custom application
can process the data without impacting the HDS.

Note

If you have used the ICMDBA tool to create an Outbound Option database on Side B of Unified CCE Rogger
and you later uninstall Packaged CCE, you can manually delete the database after the uninstallation by using
SQL Server Management Studio (SSMS).

Note

When you use the Append option to import records to the Outbound Contact Table, the size of the Blended
Agent (BA) database keeps increasing and it occupies all the available space in the disk. Hence, you must
manually purge the Outbound Contact Table to create more space on the disk.

What to do next
You must enable autogrowth on the Outbound Option database. For details, refer to the section about verifying
database configuration in the Outbound Option Guide for Unified Contact Center Enterprise at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-user-guide-list.html.

Configure the Logger for Outbound Option
Use this procedure to configure the Logger for Outbound Option.
You can (optionally) configure the Logger to enable Outbound Option and Outbound Option High Availability.
Outbound Option High Availability facilitates two-way replication between the Outbound Option database
on Logger Side A and the Outbound Option database on Logger Side B. Use the ICMDBA tool to create an
outbound database on Side A and Side B; then set up the replication by using Web Setup.
Perform the following procedure on both the Side A and Side B Loggers to configure Outbound Option or
Outbound Option High Availability. Both Logger machines must be up and operational.
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Important

Before you configure the Logger for Outbound Option High Availability:
• Confirm that an Outbound Option database exists on Logger Side A and Logger Side B.
• Create a Microsoft SQL Server user and assign that user the sysadmin privilege. Use the same username
and password on Logger Side A and Logger Side B. (You use this username and password in the following
procedure to configure Outbound Option and enable Outbound Option High Availability.)
• Assign the sysadmin privilege to the NT authority/System user.

Procedure

Step 1

Open the Web Setup tool.

Step 2

Choose Component Management > Loggers.

Step 3

Choose the Logger that you want to configure, and click Edit.

Step 4

Click Next twice.

Step 5

On the Additional Options page, click the Enable Outbound Option check box.

Step 6

Click the Enable High Availability check box to enable Outbound Option High Availability on the Logger.
Checking this check box enables High Availability two-way replication between the Outbound Option database
on Logger Side A and the Outbound Option database on Logger Side B. Two-way replication requires that
you check this check box on the Additional Options page for both Logger Side A and Side B. If you disable
two-way replication on one side, you must also disable it on the other side.
You must enable Outbound Option in order to enable Outbound Option High Availability. Similarly, if you
have enabled High Availability, you must disable High Availability (uncheck the Enable High Availability
check box) before you can disable Outbound Option (uncheck the Enable Outbound Option check box).

Step 7

If you enable High Availability, enter a valid public server hostname address for Logger Side A and Logger
Side B. Entering a server IP address instead of a server name is not allowed.

Step 8

If you enable High Availability, enter the SQL Server Admin Credentials (Username and Password) for
a user with the SQL Server System Admin privilege to establish two-way replication. Use the same credentials
on Logger Side A and Logger Side B.
SQL replication requires that the correct SQL Server system admin username and password be in place when
setting up High Availability. If you change the password for that SQL account, replication fails until you
disable High Availability and re-enable it with the new username and password. Because of this requirement,
be careful about how and when you change the password for that account.
You can use any valid SQL Server system administration account to disable High Availability. Once disabled,
you can set any valid SQL Server system administration account when you re-enable High Availability.

Step 9

Click Next.

Step 10

Review the Summary page, and click Finish.
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Change the Logger Public Interface Server Name
If it becomes necessary to change the logger public interface server name after the initial Outbound Option
replication configuration, you must disable and then re-enable replication in Web Setup. Entering an IP address
instead of a server name is not allowed.
Perform the following procedure on both the Side A and Side B Loggers. Both Logger machines must be up
and operational.
Procedure

Step 1

From Web Setup, choose Loggers.

Step 2

Choose Component Management > Loggers.

Step 3

Check the check box for the Logger whose server name you want to change, and click Edit.

Step 4

Click Next on the Deployment page and again on the Central Controller Connectivity page.

Step 5

On the Additional Options page, disable High Availability by unchecking the Enable High Availability
check box. Enter the SQL Server User Name and SQL Server User Password that you provided when you
enabled High Availability.

Step 6

Click Next.

Step 7

Click Finish.

Step 8

Return to the list of Loggers, check the check box for the Logger whose server name you want to change, and
click Edit.

Step 9

Click Next on the Deployment page and again on the Central Controller Connectivity page.

Step 10

On the Additional Options page, click the Enable Outbound Option check box and the Enable High
Availability check box.

Step 11

Change the logger public server interface name for Logger Side A and Logger Side B.

Step 12

Enter the SQL Server User Name and SQL Server User Password. (Again, this is the username and password
you provided when you enabled High Availability.)

Step 13

Click Next, and then click Finish.

Additional Two-Way Outbound Option Database Replication Consideration
Keep in mind the following consideration when setting up two-way replication.
Import to Active Side
Importing a local file succeeds only if you import it to the active side. To avoid having to identify which side
is active, you can use any of the following methods:
• Create a Microsoft Windows file share that is accessible to both sides with the same mapping; for example,
//<machine_name>/drive/file, viewable from both sides.
• Use Microsoft Windows Distributed File System (DFS). With DFS, you can set up a local drive that
DFS updates for you. DFS also makes sure that operations are replicated. For more information, see your
Microsoft documentation.
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• For campaigns created by using the Outbound API, you can use the Import API to import contacts without
identifying the active side. For more information, see the Cisco Packaged Contact Center Enterprise
Developer Reference at https://developer.cisco.com/site/packaged-contact-center/documentation/.

Add MR PIM for Outbound
Procedure

Step 1

Access the Unified CCE PG on Side A.

Step 2

From Cisco Unified CCE Tools, select Peripheral Gateway Setup.

Step 3

In the Instance Components panel of the Components Setup screen, select the PG2A Instance component
for Side A. (Select PG2B for Side B.) Then click Edit.

Step 4

In the Peripheral Gateways Properties screen, click Media Routing. Then click Next.

Step 5

Click Yes at the prompt to stop the service.

Step 6

From the Peripheral Gateway Component Properties screen, click Add and select PIM2.
Note

Select PIM2 and peripheralID 5003 even if you are not using PIM1 for another machine.

Step 7

Configure with the client type of Media Routing as follows:
a) Check Enabled.
b) Enter MR2 or a name of your choice for the Peripheral name.
c) Enter 5003 for the Peripheral ID.
d) Enter Unified CCE PG Side A IP (Side B IP for PG2B) for the Application Hostname(1).
e) Retain the default value for the Application Connection port (1).
f) Enter Unified CCE PG Side B IP (Side A IP for PG2B) for the Application Hostname(2).
g) Retain the default value for the Application Connection port (2).
h) Enter 5 for the Heartbeat interval (sec).
i) Enter 10 for the Reconnect interval (sec).
j) Click OK.

Step 8

Accept defaults and click Next until the Setup Complete screen opens.

Step 9

At the Setup Complete screen, check Yes to start the service. Then click Finish.

Step 10

Click Exit Setup.

Step 11

Repeat from Step 1 for the Unified CCE PG on Side B.

Install Dialer Component on the PG Virtual Machine
Procedure

Step 1

Stop all Packaged CCE Services.

Step 2

On both the Side A and Side B PGs, run Peripheral Gateway Setup. Select Start > All Programs > Cisco
Unified CCE Tools > Peripheral Gateway Setup.
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Step 3

In the Cisco Unified ICM/Contact Center Enterprise & Hosted Components Setup dialog, select an
instance from the left column under Instances.

Step 4

Click Add in the Instance Components section.
The ICM Component Selection dialog opens.

Step 5

Click Outbound Option Dialer.
The Outbound Option Dialer Properties dialog opens.

Step 6

Check Production mode and Auto start at system startup. These options set the Dialer Service startup type
to Automatic, so the dialer starts automatically when the machine starts up.
The SIP (Session Initiation Protocol) Dialer Type is automatically selected.

Step 7

Click Next.

Step 8

Supply the following information on this page:
• In the SIP Dialer Name field, enter the name of the SIP dialer. For example,
Dialer_for_Premium_Calling_List. There is a 32-character limit. The name entered here
must match the name that is configured in Configuration Manager.
• For SIP Server Type, select Cisco voice gateway.
• In the SIP Server field, enter the hostname or IP address of the Cisco voice gateway.
Note

The SIP Server hostnames are restricted to a maximum of 16 characters.

• In the SIP Server Port field, enter the port number of the SIP Server port. Default is 5060.
Click Next.
Step 9

On the Outbound Option Dialer Properties dialog, specify the following information:
• Campaign Manager server—The hostname or IP address of the Outbound Option server (the hostname
or IP address of Unified CCE Rogger Side A) in Packaged CCE.
• Campaign Manager server A—If the Campaign Manager is set up as duplex, enter the hostname or IP
address of the machine where the Side A Campaign Manager is located. If the Campaign Manager is set
up as simplex, enter the same hostname or IP address in this field and the Campaign Manager server
B field. You must supply a value in this field.
• Campaign Manager server B—If the Campaign Manager is set up as duplex, enter the hostname or IP
address of the machine where the Side B Campaign Manager is located. If the Campaign Manager is set
up as simplex, enter the same hostname or IP address in this field and the Campaign Manager server
A field. You must supply a value in this field.
• CTI server A—The hostname or IP address of Unified CCE PG Side A.
• CTI server port A—The port number that the dialer uses to create an interface with CTI server Side A.
The default is 42027.
• CTI server B—The hostname or IP address of Unified CCE PG Side B.
• CTI server port B—The port number that the dialer uses to create an interface with CTI server Side B.
The default is 43027.
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• Heart beat—The interval between dialer checks for the connection to the CTI server, in milliseconds.
The default value is 500.
• Media routing port—The port number that the dialer uses to create an interface with the Media Routing
PIM on the Media Routing PG. The default is 38001. Make sure the Media routing port matches that of
the MR PG configuration.
Step 10

Click Next. A Summary screen appears.

Step 11

Click Next to begin the dialer installation.

Optional - Edit Dialer Registry Value for AutoAnswer
If you enable auto answer in the CallManager with a zip tone, you must disable auto answer in the
Dialer or Dialers, if there are more than one. A zip tone is a tone sent to the agent's phone to signal
that a customer is about to be connected.
To disable auto answer in the Dialer, after the Dialer process runs for the first time, change the value
of the following registry key to 0:
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<instance_name>\Dialer\AutoAnswerCall

Auto Answer Configuration on Agent Phones
The dialer component is preconfigured during installation to auto answer Outbound Option related calls to
the Outbound Option agent. However, this default configuration does not provide a zip tone to the agent
(which notifies of incoming calls), so agents must monitor the agent application for incoming customer calls.
To enable zip tone, enable auto-answer on the agent’s phone configuration in Unified CM. This solution adds
about a second onto the transfer time. This solution is identical to the solution that is used for Unified CCE.
For Mobile Agents using the nailed connection, the Unified CM auto answer setting does not provide a zip
tone, but contact center enterprise does provide an option for playing a notification tone to the agent using
the agent desk settings.
Enabling auto answer in the agent desk settings or in the dialer component in conjunction with the Unified
CM can be problematic. Therefore, disable the auto answer option in the dialer component, and enable it either
in the agent desk settings or in Unified CM.

Verify connections
The Diagnostic Framework Portico provides details about the health of the installation even before any
campaign configuration is initiated or before any call is placed. The interface contains the following details
about the dialer status.
Procedure

Step 1

Navigate to the Outbound Option Dialer component in the Diagnostic Framework Portico.
The Node Name is Dialer. The Process name is BADialer.
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Step 2

Verify that the Campaign Manager (CM) has a status of Active (A).

Step 3

Verify that the CTI Server (CTI) has a status of Active (A).

Step 4

Verify that the number of Configured Ports equals the number of Ready Ports.

Step 5

Verify that the MR has a status of Active (A).

Maintenance Considerations
This section contains information about maintaining the Outbound Option application.

SIP Dialer Voice Gateway Over-capacity Errors
If your network monitoring tool receives an alarm in the SIP dialer about being over capacity, you can ignore
the alarm unless it becomes an ongoing issue. This section describes the source of the alarm and remedial
actions associated.
If the Voice Gateway in a SIP dialer implementation is over capacity, the SIP Dialer receives the following
message: SIP 503 messages if the SIP Dialer is deployed with Voice Gateway
only
If the percentage of SIP 503 messages reaches 1% of all messages, the SIP dialer raises an alarm.
Use one of the following measures to attempt to remedy the problem if Voice Gateway capacity becomes an
ongoing issue:
• Check the Voice Gateway configuration. If there are errors, fix them and reset Port Throttle to its original
value. Port Throttle (the calls-per-second rate at which the dialer dials outbound calls) is set on the Dialer
General tab in the Configuration Manager.
• Check the sizing information. Adjust the value of Port Throttle according to the documented guidelines.
• Enable the auto-throttle mechanism by setting the Dialer registry setting EnableThrottleDown to 1.
To set EnableThrottleDown, open the Registry Editor (regedit.exe) on the PG machine and navigate
to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<customerinstance>\Dialer.
The SIP dialer performs an automatic throttle down when the percentage of SIP 503 messages reaches 2% of
all messages, if the auto-throttle mechanism is enabled. This throttle down means that the SIP dialer decreases
the configured value of Port Throttle by approximately 10%.
If one throttle down does not correct the problem, the SIP dialer performs more throttle downs until either
the problem is corrected or the value of Port Throttle is throttled down to 50% of the originally configured
value. Even after the problem is corrected, the dialer does not automatically throttle back to the configured
value. To overcome this problem, run the updateportthrottle /portthrottle <configured value> command
using the process monitoring tool Procmon to increase the throttle back to the configured value.
For each automatic throttle down, alarm and trace messages clearly provide detailed information about the
adjusted port throttle value, configured port throttle value, and time duration.

Update the North American Numbering Plan Data
The Regional Prefix Update Tool (RPUT) is used to update the Packaged CCE database to the latest North
American Local Exchange NPA NXX Database (NALENND).

Outbound Option
27

Outbound Option
Update the North American Numbering Plan Data

You can use this tool only if Packaged CCE is using the North American Numbering Plan.
The RPUT is composed of the following two files (installed in the ICM\bin directory on the Unified CCE
AW-HDS-DDS server):
• region_prefix_data.txt (or the <DatafileName>)
Contains the data this tool uses to update the region prefix table in the Packaged CCE database. Note
that you should change paths to the ICM\bin directory.
• regionfix.exe
This executable reads the region_prefix_data.txt data file and updates the region prefix table.
The RPUT is run from the command line as described in the following procedure.
Procedure

Step 1

Open a command prompt (Select Start > Run, and enter cmd, then click OK).

Step 2

Change the path to ICM\bin.

Step 3

Enter the following at the prompt: regionfix.exe
the data file).

<DatafileName>

(where <DatafileName> is the name of

The Regional Prefix Update Tool then shows the version of the input data file and asks if you want to proceed.
If you proceed, the tool connects to the Packaged CCE database. The number of records that are to be updated,
deleted, and inserted appear. These records are put into three different files:
• region_prefix_update.txt (which includes preserved Custom Region Prefixes)
• region_prefix_new.txt
• region_prefix_delete.txt
Step 4

You can either delete or retain the entries present in the region_prefix_delete.txt file while performing the
insertions and updates. To retain the entries, type No when the tool prompts you to delete the entries. Type
Yes to delete the entries.

Step 5

Check the contents of the files before proceeding.

Step 6

Answer Yes to proceed with the update.
When the update is complete, the tool displays the following message:
Your region prefix table has been successfully updated.
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Campaign configuration
Campaign Task List
The following table lists the steps that are required to create both an agent and IVR campaign, and the location
of the instructions for the task.
Table 4: Steps for Creating a Campaign

Step Number

Task

Where Discussed

1

Create one or more skill groups for the campaign.

Configure Skill Group, on
page 30

2

Configure the call type using the Packaged CCE Call Type
gadget.

Create a Call Type, on
page 30

3

Create a dialed number on the MR client using the Packaged Configure Dialed
CCE Dialed Number gadget. This dialed number is for agent Numbers, on page 30
reservation.

4

Create DN for Abandon to IVR on the MR PG for the SIP
dialer.

5

Create DN for AMD to IVR on the MR PG for the SIP dialer. Configure Dialed
Numbers, on page 30

6

Configure import rule using the Outbound Option Import
Rule Tool.

7

Configure query rules using the Outbound Option Query Rule Create a Query Rule, on
tool.
page 37

8

Configure a campaign using the Outbound Option Campaign Create a Campaign, on
tool.
page 37

9

Configure a routing script using the Script Editor.

Set Up Routing Scripts, on
page 56

10

Configure an administrative script using the Script Editor.

Set Up Administrative
Scripts, on page 52

11

Voice gateway configuration.

Voice Gateway and
Unified CVP
Configuration for a VRU
Campaign, on page 50

Configure Dialed
Numbers, on page 30

Create Import Rule, on
page 30
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Configure Skill Group
Add at least one skill group. For an agent campaign, add at least one agent to the skill group. Log the agent
in to the skill group, and make the agent ready for the agent campaign. You do not need to add an agent for
a VRU campaign skill group. For information about configuring skill groups, see the Cisco Packaged Contact
Center Enterprise Administration and Configuration Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/packaged-contact-center-enterprise/products-maintenance-guides-list.html.

Create a Call Type
The dialed numbers and routing scripts that you will create will reference call types, so you should create
them as needed. For information about creating call types, see the Cisco Packaged Contact Center Enterprise
Administration and Configuration Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/
packaged-contact-center-enterprise/products-maintenance-guides-list.html. For example, you can create one
call type for an agent campaign and another for a VRU campaign. You need to associate the call types with
the dialed numbers you created earlier.

Configure Dialed Numbers
Configure at least two dialed numbers on the outbound routing client: one for the agent campaign and one
for the VRU campaign. See the Cisco Packaged Contact Center Enterprise Administration and Configuration
Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/packaged-contact-center-enterprise/
products-maintenance-guides-list.html for information about configuring dialed numbers.

Create Import Rule
The Import Rule defines how Outbound Option:
• Locates the imported file and defines the name of the contact table into which the import process places
the contact information.
• Recognizes and defines the contact list data in the imported file. The Import Rule defines the import
format of the user contact list (fixed length, comma-delimited, or pipe delimited fields), and the information
to be found in the fields of the file, such as the first and last names of contacts.
• Schedules updates for your calling lists imports.
There are two types of import rules in Outbound Option:
• Contact - An import rule that you create for a specific campaign. It is possible to have a single import
rule with many contacts, and use query rules to separate those contacts into different campaigns.
• Do Not Call - An import rule, created once and applicable to all campaigns, that provides do-not-call
information to all campaigns.

Note

When you modify an existing import rule to add or modify a custom field in the table, change the target table
name. If you retain the same target table name, the custom field modification is not saved to the table.
Changing the target table name creates a new table, but does not remove the old table. The old table remains
in the database, but the system does not use it.

When you import records, take note of the following:
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• The dialing rate/CPS is affected.
• The “record fetch query performance” is also affected if you are importing huge number of records. The
performance of the query impacts the call rate.
Perform the following steps to create an import rule.
Procedure

Step 1

In Unified CCE Configuration Manager, expand the Outbound Option menu, then double-click the Outbound
Option Import Rule component.

Step 2

Click Retrieve.

Step 3

Click Add at the bottom of the list box area of the window. Then fill out the information that is required on
the following tab pages:
a) Import Rule General tab
b) Import Rule Definition tab
c) Import Rule Schedule tab

Step 4

Click Save.

Note

If you edit an import rule, the changes that you make to that import rule take effect on the next import.

Import Rule General Tab Page
Specify the following information on the Import Rule General tab page.
Field

Description

Import name (required)

There is a 32-character limit.

Enable option

This option enables or disables importing for the import rule.

Import type

Select either Contact or Do_Not_Call from the drop-down list.
Note

Target table name (required)

If you are creating a Do_Not_Call import, be sure to also
properly format the Do Not Call list file. If you are
creating a contact import, format the contact import file.

If you selected Do_Not_Call as the import type, the Import Rule
component automatically assigns it to the DoNotCall table.
If you selected Contact as the import type, you can enter any name
for the target table within the following restrictions:
The name must be a maximum 32-character string, including
alphanumeric characters, periods (.), underscores (_), and hyphens
(-). Alphabetic characters can be upper- or lowercase. The name
must begin with an alphanumeric character and must not contain
spaces.
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Field

Description

Import file path (required)

Enter the directory path name for the import file.
Enter the directory path name for the import file on the active
Logger side (either Logger A or Logger B). You can use a Microsoft
Windows file share or Microsoft Windows DFS in place of a fully
qualified path, to avoid needing to know which side is active.
The maximum number of characters allowed is 255. Click Browse
to the right of the Edit field to browse for the location.

Import data type

Select the Comma delimited, the Pipe delimited, or the
Fixed-length setting, to indicate if the file is comma-delimited,
pipe-delimited, or if it uses fixed-length columns to separate fields.

Overwrite table

When this option is enabled, you can overwrite the current import
with a new import.
When this option is disabled, new import data is appended to the
existing data. You cannot append a new field to existing import
data. Also, you cannot modify or remove existing fields.
Note

Do not perform a file import with the Overwrite table
option while a campaign is in progress. If you do, the
dialer becomes unable to access records, because a
database operation is in progress on the dialing List table.

Import Rule Definition Tab Page
Specify the following information on the Import Rule Definition tab page.
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Field

Description

Standard column type

Choose a column type to use for this data field in the import rule.
The following column types are allowed:
• AccountNumber - VARCHAR (30)
• Custom
• FirstName - VARCHAR (10)
• LastName - VARCHAR (20)
• Phone01 through Phone10 - VARCHAR (20)
Allowed data: digits 0-9, pound sign (#), and asterisk (*)
• PhoneExt01 through PhoneExt10 - VARCHAR (8)
This column is for future use. Do not use it.
Outbound Option removes single quotation marks present in the
Import file.
Outbound Option does not send data from Custom columns to the
agent desktop. They are available for use only in the query rule
select clause for business-specific filtering into different dialing
lists.

Field name

The name that you assign to this field, disabled unless you select
Custom for the Standard column type. The maximum length is 32
characters.

Type

The field name and its drop-down list are disabled unless you select
Custom for the Standard column type. For a Custom type, select
the data type that this field uses. The following Custom column
types are allowed:
• Custom CHAR (up to 255 characters)
• Custom VARCHAR (up to 255 characters)
• Custom DATETIME (date followed by time: MM/dd/yy
HH:mm:ss)
• Custom REAL (up to 4 characters, including the decimal point)
• Custom INT (up to 255 characters; decimal point counts as
one character.)
The default is the VARCHAR data type.

Field length (1-255)

The number of characters that this field uses to store data. The
default is 1.
Note

The actual field length varies depending on the field.
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Field

Description

Allow nulls to be entered for this field If you enable this option, you can have empty data in the import
file for this column.
If you disable this option, you must have data.
The default is Disabled.
Imports
This section provides procedures for creating an import rule file, creating a Do Not Call list, and adding
attributes for a contact list.

Import Procedure
Before you run an import, first create an import rule file that contains the data to be imported. This import
rule file can have a maximum of 1024 characters per row, and can be in one of three formats:
• Comma Delimited - Each column's data is separated by a comma.
• Fixed Format - Each column has a fixed character width as specified on the Definition tab of the Import
rule tool. The number of characters in the entry for each column must exactly match the column definition.
If the data for a field does not fill the specified width of the column, pad the entry with spaces to the
defined character width.
• Pipe Delimited - Each column's data is separated by a pipe.

Create Do Not Call List
When creating a Do_Not_Call list file, format it correctly using the following instructions.
Procedure

Step 1

Using a text editor, create a text file that contains all the do-not-call phone numbers.

Step 2

Enter a phone number for each Do Not Call entry on a new line.

Step 3

Observe the following characteristics for each Do Not Call entry:
• Each phone number can be a maximum of 20 characters long.
• The Do Not Call table can support up to 10 million entries, but note that the information is also stored
in memory in the Campaign Manager process. Unless you set the Overwrite table option, each import
appends to the table. A single large import or several smaller ones can create a Do Not Call list in memory
that consumes all the memory for the process.

Step 4

Save the text file to the local server.

The following is an example of a Do_Not_Call list:
2225554444
2225556666
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2225559999

To add a customer to this list, import a Do Not Call list.
The Campaign Manager reads from the Do_Not_Call table. Dialing List entries are marked as Do Not Call
entries only when the Campaign Manager fetches the Dialing List entry and only when there is an exact,
digit-for-digit match. This allows Do Not Call imports to happen while a Campaign is running without
rebuilding the Dialing List.

Note

If the Dialing List includes a base number plus extension, this entry must match a Do Not Call entry for that
same base number and same extension. The dialer will not dial the extension.

Note

To clear the Do Not Call list, import a blank file with the Overwrite table option enabled.

Create Contact Import File
When creating a contact import file, observe the format you designed according to the database rules set up
in Import Rule Definition Tab Page.
The following example assumes that you have contact information with AccountNumber, FirstName, LastName,
and Phone column types.
Procedure

Step 1

Using a text editor, create a text file that contains the information for these fields.

Step 2

Enter an account number, first name, last name, and phone number for each entry on a new line.
Use either Comma Delimited, Pipe Delimited, or Fixed Format, as defined on the Import Rule General Tab
Page.

Step 3

Save the text file to the local server.

Example
The following is an example of a contact import file in the comma-delimited format:
6782,Henry,Martin,2225554444
3456,Michele,Smith,2225559999
4569,Walker,Evans,2225552000

The following is the same example in Fixed Format with the following column definitions:
• Custom - VARCHAR(4)
• FirstName - VARCHAR(10)
• LastName - VARCHAR(20)
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• Phone - VARCHAR(20)
6782HenryMartin2225554444
3456MicheleSmith2225559999
4569WalkerEvans2225552000

Import Rule Schedule Tab Page
Specify the following information on the Import Rule Schedule tab page.
Field

Description

Schedule start time

Enter or select the time when the process starts. Because the setting
uses 12-hour time notation, be sure to select AM or PM. The time
is based on the local time at the Unified CCE AW-HDS-DDS. The
default is 9:00 AM.

Weekly option

Enable this option for the import rule process to execute on the
same days each week. Enable the days of the week when you want
the process to execute. Disable this option if you do not want the
process to execute weekly.

Monthly option

Enable this option for the import rule process to execute on selected
days each month. Enter the day of the month on which you want
the process to execute. If you select a date that does not occur during
a particular month, such as the 31st day of April, the import does
not execute on that month.

Start import when file is present
option

Enable this option to import a file as soon as it is copied into the
specified location. The folder that you specify must have write
permissions. Otherwise, import file copying and renaming cannot
occur.
The import process polls every second to see when the import file
becomes available. After the file is available, the import begins
immediately.

Rename File After Import

When selected, specifies that the import file is renamed by
appending “.bak” to the filename after the import is complete.

Delete File After Import

When selected, specifies that the import file is deleted after the
import is complete.

Import Rule Deletion
When you delete an import rule, the corresponding contact table is deleted.
If you are using Outbound Option High Availability and either Side A or Side B is down when the rule is
deleted, the corresponding table on that side is not deleted. However, when the side restarts, the table is then
automatically deleted.
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Create a Query Rule
The Query Rule component defines the SQL rule that the Outbound Option Import process uses to build the
dialing list for a particular campaign. Based on SQL queries to the database, the rule defines how the contact
records from the Outbound Option database are selected to be inserted in the dialing list.
Perform the following steps to create a query rule.
Procedure

Step 1

In Unified CCE Configuration Manager, expand the Outbound Options menu, then open the Outbound Option
Query Rule component.

Step 2

Click Retrieve.

Step 3

Click Add at the bottom of the list box area of the window.

Step 4

Fill in the appropriate information on the Query Rule General tab page. See the online help for details of the
fields on this tab.

Step 5

Click Save.

Delete a Query Rule
When you delete a query rule, the corresponding Dialing List table is also deleted.
If you are using Outbound Option High Availability and either Side A or Side B is down when the rule is
deleted, the corresponding table on that side is not deleted. However, when the side restarts, the table is then
automatically deleted.

Create a Campaign
Use the Outbound Option Campaign tool to add, delete, and modify campaigns.
Before you create a campaign, first configure the following information:
• At least one skill group
• At least one query rule
• The following dialed numbers with Routing Type set to Outbound Voice:
• One for accessing the agent reservation script (not required for transfer to VRU campaigns).
• One for transferring the call to the VRU for abandon treatment when no agents are available. This
number must be different from the previous number.
• One for transferring the call to the VRU for answering machine detection (AMD) or transfer to
VRU campaign treatment. This number can be the same as the previous number, but different from
the first number.
Perform the following steps to create a campaign.
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Procedure

Step 1

In Unified CCE Configuration Manager, expand the Outbound Option menu, then open the Outbound Option
Campaign component.

Step 2

Click Retrieve.

Step 3

Click Add at the bottom of the list box area of the window.

Step 4

Fill in the fields described on the following tabs. See the online help for detailed descriptions of the fields:
a) Campaign General tab.
b) Campaign Purpose tab.
c) Query Rule Selection tab.
d) Skill Group Selection tab.
e) Call Target tab.

Step 5

Click Save.

Campaign General Tab Page
Specify the following information on the Campaign General tab page.
Field

Description

Campaign Name (required)

Maximum 32-character string, including alphanumeric characters,
periods (.), and underscores (_). Alphabetic characters can be upperor lowercase. The name must begin with an alphanumeric character.

Description

Optional description for the campaign; maximum 255 characters.

Enable option

This option enables or disables the campaign.

Power Dialing Section
Lines per agent (required)

The number of lines dedicated to each agent in this campaign. If this
value and the Maximum lines per agent value are both set to 1, the
mode defaults to Progressive.
Default = 1.5 (Three lines for every two agents.)
Allowable Range = 1 – 100
This value performs as follows in the Outbound Option dialing modes:
• Preview and Direct Preview mode: Ignored (always 1).
• Progressive mode: Used as defined.
• Predictive mode: Used as an initial value.

Dialing Options Section
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Field

Description

Maximum lines per agent
(required)

The upper bound for the number of customers the dialer dials for a
reserved agent at a time when the campaign is running in predictive
mode.
Default = 2
Range = 1 – 100

Abandon calls limit (1-100)
(required when enabled)

This option only applies to Predictive campaigns.
Enable this option to set an Abandon calls limit (1-100) for the
percentage of abandoned calls in this campaign. The granularity is to
one-tenth of a percent. Default = 3.0.
If the option is disabled, the campaign dials without regard to the
abandon limit.
Note

Advanced

A call is considered abandoned if a person answers it and
the contact center does not connect the call to a sales
representative within two seconds of the person's completed
greeting.

Clicking the Advanced button opens a Predictive Dialing Settings
dialog box. On this dialog box, you can change the Voice Calls Per
Adjustment and the Gain parameters that control how adjustments are
made to the lines per agent in this campaign. Accept the default in
most cases. For more information, see Parameter Tuning, on page 41.

Dial Settings Section
No answer ring limit (2 to 10)

Defines the number of times the software allows a dialed telephone
number to ring. Enter the maximum number of rings allowed. The
length of one ring is specified at the dialer level in the
TimeToRingCustomer registry entry. Default = 4.
Note

Maximum attempts (1 to 100)

The default behavior is to allow calls to ring for 32 seconds
(No answer ring limit –4, TimeToRingCustomer key –8
seconds). Assuming the default 8-second
TimeToRingCustomer key is used, setting the "No answer
ring limit" to the minimum 2 rings meets 15-second
ring-time requirements.

Defines the maximum number of attempts, including callbacks and
retries. Enter the maximum number of attempts to be made in zone 1
and zone 2. Default = 3. Increasing the number of attempts causes
closed records to be reopened, which can result in slower performance.
For more information, see Modification of Maximum Number of
Attempts in a Campaign, on page 41.
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Field

Description

Abandoned call wait time (0 to 10) Minimum duration (in seconds) of an outbound call. If the duration
of an outbound call is less than this specified value, Outbound Option
(required)
considers the call as customer abandoned, and the customer record
that is associated with that call is scheduled for a retry. To disable this
feature, set this value to 0. Enter the number of seconds. Default = 1.
If this feature is disabled, then Outbound Option does not consider
this call as customer abandoned. It affects the reporting of this call in
the Outbound Option dialer_detail table.
Campaign Prefix Digits

Digits to be prefixed to each customer number dialed from this
campaign. For the SIP Dialer, this field represents the phone number
that is advertised as the calling number for the campaign. Enter a
maximum of 15 digits in this field.

Retries Section
No answer delay

Defines (in minutes) how often the software waits before calling back
a no-answer call. Enter the number of minutes. Default = 60.

Busy signal delay

Defines (in minutes) how long the software waits before calling back
a busy telephone number. Enter the number of minutes. Default = 60.

Customer abandoned delay

If a customer abandons a call, the time (delay in minutes) before the
dialer calls the customer back. Default = 30.

Dialer abandoned delay

If the dialer abandons a call, the time (delay in minutes) before the
dialer calls the customer back. Default = 60.

Answering machine delay

If an answering machine answers the call, how long the software waits
(in minutes) before calling back. Default = 60.

Customer not home delay

If the customer was not at home and should be called back, the time
(in minutes) before the dialer calls the customer back. Default = 60.

Callback Settings Section
Personalized callback

Enables the personal callback option. This option allows an agent to
schedule a callback to a customer for a particular date and time, which
connects the customer to the agent they originally spoke to at the time
the customer requested.

Reschedule callback mode
(required)

Determines how Outbound Option handles the personal callback if
the agent is not available:
• Use Campaign DN.
• Reschedule the personal callback to the same time the next
business day.
• Abandon the personal callback.
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Modification of Maximum Number of Attempts in a Campaign
You can recall customers who were previously not reached without having to import their phone numbers
again by increasing the maximum number of attempts amount in the Maximum attempts field on the Campaign
General tab page This option is useful if the campaign import is an append type instead of an overwrite type.

Note

Do not update the Maximum attempts field while the campaign is in progress. Modifying this option in the
campaign configuration results in an update of all customer records that were not successfully contacted. The
Campaign Manager can update only about 20 records per second, and no new customer records are delivered
to the dialer for this campaign while this update is in progress.

You can view how many records have been closed and how many were successfully reached by using the
Call Summary Count per Campaign Real Time report. See Reports, on page 64 for more information.

Parameter Tuning
The Voice Calls Per Adjustment and Gain parameters are settings in the Advanced Users configuration tab
used to control the way the predictive dialing behaves. Do not modify the default values unless you understand
the parameters and the possible risks incurred when changing the pacing.
• The Voice Calls Per Adjustment parameter is a count of the number of live voice connections that are
required to trigger a correction. (The default value is 70 voice calls.) If the abandon rate exceeds the
target by a significant margin, the dialer can make corrections before collecting 70 calls.
• The Gain parameter controls the size of the Lines per agent corrections.
Setting the Voice Calls Per Adjustment parameter to a smaller setting leads to larger fluctuations in the
measured Abandon Rate because the sample size is less significant. This results in less change in the Lines
per agent value over time.

Caution

Be careful when modifying both parameters (Gain and Voice Calls Per Adjustment) at the same time. For
example, increasing the Gain while decreasing the Voice Calls Per Adjustment results in larger changes in
the “Lines per agent correction rate,” which might overcorrect changes in measured values.
Decreasing the Gain while increasing the Voice Calls Per Adjustment can similarly cause too slow of a change
to underlying changes in the hit-and-abandon-rates. A campaign that is reaching more than 20 live voice
customers every minute (600 per half hour) might benefit from reducing the Gain, but a lower Gain becomes
less effective as the number of agents in the campaign dwindles or the hit rate changes rapidly.

Campaign Purpose Tab Page
Specify the following information on the Campaign Purpose tab page.
Field

Description

Agent Based Campaign
Agent Based Campaign

This type of campaign uses an outbound mode that causes the dialer
to transfer every customer call that is associated with a specific skill
group to an agent.
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Field

Description

Enable IP AMD

Selecting this option enables answering machine detection for the IP
dialers in the system only. If this option is enabled, when the dialer
detects an answering machine, it performs one of the following actions.
(Default = Enabled.)
• Abandon Call (default): Drops the call, marks it as an answering
machine, and schedules a retry.
• Transfer to Agent: Transfers the call to an agent.
• Transfer to IVR Route Point: Transfers the call to play a
prerecorded message. (The IVR route point is configured in the
Skill Group Selection dialog box in the Campaign Skill Group
Selection tab.)
Note

Once transferring to an agent or to a VRU is
configured, there is no way to set the AMD records
as Retry. Use a customized query to identify such calls
and create a new campaign.

• Terminate Tone Detect: Transfers the call after detecting the
answering machine beep.
Call Progress Analysis

If this option is disabled, all Call Progress Analysis for all calls made
from this dialer is disabled on a campaign-by-campaign basis, including
voice detection, fax/modem detection, and answering machine
detection. (Default = Disabled.)
If Call Progress Analysis is enabled, specify the Record CPA
parameter. The Gateway provides a media stream and the dialer records
.wav files. This parameter improves Call Progress Analysis
performance.
Note

If you have a SIP dialer, enable IP AMD for Call Progress
Analysis to function. If you do not enable IP AMD, the SIP
dialer instructs the gateway to transfer the call to agent
without waiting for detection.

Transfer to IVR Campaign
Transfer to IVR Campaign
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Field

Description

Enable IP AMD

Selecting this option enables answering machine detection for the IP
dialers in the system only. If this option is enabled, when the dialer
detects an answering machine, it does one of the following actions.
(Default = Enabled.)
• Abandon Call (default): Drops the call, marks it as an answering
machine, and schedules a retry.
• Transfer to IVR Route Point: Transfers the call to play a
prerecorded message. (The IVR route point is configured in the
Skill Group Selection dialog box in the Campaign Skill Group
Selection tab.)
Note

Once transferring to an agent or to an IVR is
configured, there is no way to set the AMD records
as Retry. Use a customized query to identify such calls
and create a new campaign.

• Terminate Tone Detect: Transfers the call after detecting the
answering machine beep.
Call Progress Analysis Parameters
Minimum Silence Period
(100-1000)

Minimum silence period required to classify a call as voice detected.
If many answering machine calls are being passed through to agents
as voice, then increasing this value accounts for longer pauses in
answering machine greetings. Default is 608.

Analysis Period (1000-10000)

Number of milliseconds spent analyzing this call. If there is a short
agent greeting on an answering machine, then a longer value here
categorizes that answering machine call as voice. If the call is to a
business where the operator has a longer scripted greeting, a shorter
value here categorizes the long, live greeting as answering machine.
Default is 2500.

Minimum Valid Speech (50-500)

Minimum number of milliseconds of voice required to qualify a call
as voice detected. Default is 112.

Maximum Analysis Time
(1000-10000)

Maximum number of milliseconds allowed for analysis before
identifying a problem analysis as dead air/low volume. Default is
5000.

Maximum Termination Tone
Analysis (1000-60000)

Maximum milliseconds the dialer analyzes an answering machine
voice message looking for a termination tone. If the message has an
odd tone and the analysis does not recognize it, the call is not
transferred or dropped until this timeout occurs. Default is 30000.

Reset to System Default

Resets all items in the Call Progress Analysis (CPA) Parameters section
to the system defaults.
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Query Rule Selection Tab Page
Press the Add button on the Query Rule Selection tab page and specify the following information.
Field

Description

Query rule name

The name of the query rule.

Enable

Enables the query rule for this campaign. Default = Enabled.

Start time

The local time at the Central Controller when a query rule can begin
to execute.

End time

The local time at the Central Controller when a query rule must stop
executing.

Penetration (0-400):

The maximum number of calls that this campaign tries during a query
rule execution; for example, 400 contact attempts. When a query rule
reaches the penetration number, it stops executing and the next query
rule in the list begins to execute. Default = 100. If this option is
enabled, Duration and Hit Rate are disabled.

Duration (0-120):

The total amount of time that this query rule can run; for example, 30
minutes. When the query rule reaches the time limit, it stops executing
and the next query rule in the list can begin to execute. Default = 30.
If this option is enabled, Penetration and Hit Rate are disabled.

Hit Rate (0-100):

The minimum percentage of calls that can be answered (excluding
answers by answering machines) during this query rule execution; for
example, 30 percent. If the hit rate drops below this value, the next
query rule begins to execute. Default = 30. If this option that is enabled,
Duration and Penetration are disabled.

Skill Group Selection Tab Page
From the Skill Group Selection tab page, click Add to display a pop-up window listing the configured
Peripherals and specify the following additional information.
Field

Description

Skill Group Name The name of the skill group assigned to this campaign.
Overflow Agents
per Skill (0-100)

For Progressive campaigns, this setting can reduce the abandon rate at the cost of
increasing agent idle times. It ensures that there is always at least one extra agent
reserved before the Dialer dials. This increases the odds that an agent is available when
two or more customers answer.
When this is set to 1, at least two agents must be reserved before dialing begins.
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Field

Description

Dialed number

For agent campaigns only. Enter the dialed number to reserve an agent in the configured
skill group.
This field only accepts 10 characters. If you paste in a longer dialed number, only the
first 10 characters are saved.
Valid characters are only alphanumeric, periods (.), and underscores (_). Special
characters are not permitted.

Records to cache
(1-400)

The minimum number of dialing numbers that each dialer caches for each of your
Outbound Option skill groups. Default = 1.
This value cannot exceed 400 records for all active skill groups.

Number of IVR
Ports

The total number of VRU ports that are allocated for the specific skill group. This
value indicates how many ports are available for the dialer to transfer customer calls.
Because this value indicates the total number of ports supported by the VRU for the
current skill group, multiple skill groups can make transfer-to-VRU calls.
They also use one VRU to play different messages based on the route point where the
contact is transferred. If there are multiple dialers associated with this skill group, each
dialer dials a fraction of the total number of ports.
Route Points for Transferring to an IVR

After AMD and for For Transfer to IVR campaigns or campaigns that transfer AMD calls to an IVR. This
number indicates the route point required to execute the transfer to IVR routing script.
transfer to IVR
This number must coincide with a route point configured on Unified CM and be
campaigns
assigned to the PGUser. Contacts are transferred to this route point, which points to a
routing script. This script transfers the call to an IVR. The Campaign Manager uses
only the first 10 digits that are entered.
When no agents
are available

For Transfer to IVR campaigns or campaigns that transfer AMD calls to an IVR. This
number enables the Dialer to play a message to any calls about to be disconnected due
to lack of available agents. This number must coincide with a route point configured
on Unified CM and be assigned to the agent PG's CTI application (for example,
PGUser). Contacts are transferred to this route point, which points to a routing script.
This script transfers the call to an IVR. The Campaign Manager uses only the first 10
digits that are entered.
Filter

Peripheral

The name of the Peripheral to which the Skill Groups assigned to this campaign are
configured.

Skill Group
Condition

Select the condition for filtering the skill groups associated with the selected peripheral,
and then click Retrieve.
• None - This value means that no filter is selected and Value filter is ignored. All
Skill Group records assigned to the selected peripheral are displayed.
• Contains, Ends With, Starts With - Select one of these conditions and enter an
appropriate entry in the Value field. The filtered Skill Group records assigned to
the selected peripheral are displayed.
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Field

Description

Value

The entry in this field is based on the selections made in the Skill Group Condition
field. If None is selected, this field is ignored.

Retrieve

Click this button to retrieve and display data based on the Peripheral, Skill Group
Condition, and Value filters.
Pagination
These controls apply to the Skill Group Name.

Page

Enter a page number to display a page of retrieved skill groups.

Forward

Enabled when a retrieve operation retrieves more than 100 skill groups. Click to display
the next 100 skill groups.

Reverse

Enabled when a retrieve operation retrieves more than 100 skill groups from the ICM
database. Click to display the previous 100.

Of

This displays the total number of skill groups retrieved.

Call Target Tab
Specify the following information on the Call Target tab.
Field

Description

Daylight Savings Zone (required)

Describes the default time zone to use for any numbers dialed which
do not map to the Outbound Option region prefixes.

Zone 1 and Zone 2 options

Enable this option, and then enter the start and end times for reaching
your calling targets. Zones are useful for distinguishing phone
locations. For example, Zone 1 can be designated as work, and Zone
2 can be home.
Note
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zones at the same time. However, Zone 1 time and Zone 2
time cannot overlap.
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Field

Description

Numbers to dial

Lists the phone numbers in dialing order for the Zone 1 or Zone 2.
• To move a phone number into the Numbers to dial list, click a
number in the Available numbers list and then click the left arrow
to add it to the Numbers to dial list. Do not move phone numbers
after the campaign has started. Number added after while the
campaign is running might not be dialed.
• To remove a phone number in the Numbers to dial list, click the
number and then click the right arrow to add it to the Available
numbers list.
• To control the dialing order, use the up and down arrows to move
the phone numbers within the Numbers to dial list.
Note

Customers are dialed based on the time zone of the first
phone that is configured on this tab. The time zone is based
on the prefix of the phone number and the region prefix
configuration. If two phone numbers that are imported for
the same customer have different time zones, both phones
are called during times that are valid for the first phone.

Contains the available phone numbers that can be added to the
Numbers to dial list for Zone 1 or Zone 2.

Available numbers

Notes on Editing a Campaign in Progress
You can edit most campaign configuration settings while a campaign is running. The changes take effect with
new calls after the setting has been changed. However, do not edit the following settings while a campaign
is in progress:
• Do not modify the MaxAttempts value. Modifying this value while a campaign is in progress can cause
a long delay in record retrieval and longer agent idle times.
• Do not delete a skill group while a campaign is in progress.

(Optional) Configure Personal Callbacks
Personal Callback is an optional feature in Outbound Option. Personal Callback enables an agent to schedule
a callback to a customer for a specific date and time. A personal callback connects the agent who originally
spoke to the customer back to the customer at the customer-requested time.
This section describes how to configure your system to handle personal callbacks. When you create campaigns,
you enable the callback feature individually for each campaign.
The following table outlines the process.
Table 5: Personal Callback Configuration Steps

Step Number

Procedure Description

1-6

Configure a campaign.
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Step Number

Procedure Description

7

Configure a call type for personal callback.

8

Configure a correctly named dial number.

9

Configure a routing script.

10

Configure registry keys.

11

Configure Queue to Agent node.

Procedure

Step 1

In the Unified CCE Configuration Manager, select Outbound Option.

Step 2

In the Campaign tool, select the Campaign General tab.

Step 3

Open a predefined campaign.

Step 4

Check personal callback.
Personal callback is now enabled. Next, you configure the personal callback registry entries.

Step 5

Configure a call type for personal callback.
For information about creating call types, see the administration documentation.

Step 6

Create a dialed number with the name PersonalCallback on the outbound routing client.
For information about configuring dialed numbers, see the administration documentation.

Step 7

Open regedit on the Rogger.

Step 8

Navigate to the following locations: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<instance name>\LoggerA\BlendedAgent\CurrentVersion and
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance
name>\LoggerB\BlendedAgent\CurrentVersion in the Outbound Option registry.

Step 9

Configure the personal callback registry entries listed in the following table. (Enter the values in decimal
format.)
Note

Outbound Option enforces at runtime the minimum and maximum values in the table. The registry
does not validate the values.

Name

Default Description
Value
(integers)

CallbackTimeLimit

15
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Calculates the callback time range, in minutes, for each
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CallbackDateTime value is between the current time
and the CallbackTimeLimit.
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Name

Default Description
Value
(integers)

PersonalCallbackTimeToRetryBusy

1

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying a personal callback
to a busy number. The valid range is from 1 to 10.

PersonalCallbackTimeToRetryNoAnswer 20

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying an unanswered
personal callback. The valid range is from 5 to 60.

PersonalCallbackTimeToRetryReservation 5

Sets the amount of time, in minutes, that the Outbound
Option Dialer waits before retrying to reserve an
unavailable agent. The valid range is from 1 to 10.

PersonalCallbackMaxAttemptsDefault 5

Sets the maximum number of times a personal callback
is attempted. The valid range is from 1 to 10.

PersonalCallbackTimeToCheckForRecords 5

The interval time, in minutes, at which the Outbound
Option Dialer checks the Campaign Manager for
personal callback records. The valid range is from 1 to
30.

PersonalCallbackDaysToPurgeOldRecords 5

The number of days after the personal callback was
scheduled (CallbackDateTime) to keep the record before
purging it. The valid range is from 1 to 30.

PersonalCallbackRecordsToCache

20

The number of personal callback records to send to the
Outbound Option Dialer at one time. The valid range
is from 5 to 200.

PersonalCallbackSaturdayAllowed

0

Indicates whether personal callbacks are allowed on
Saturdays:
• 0: Personal callbacks are not allowed on Saturdays
and are rescheduled for the next allowable day.
• 1: Personal callbacks are allowed on Saturdays.

PersonalCallbackSundayAllowed

0

Indicates whether personal callbacks are allowed on
Sundays:
• 0: Personal callbacks are not allowed on Sundays
and are rescheduled for the next allowable day.
• 1: Personal callbacks are allowed on Sundays.
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Name

Default Description
Value
(integers)

PersonalCallbackCallStatusToPurge

C, M

If needed, create this registry entry.
String containing the call status types to consider when
purging old personal callback records. For example, if
the string contains “C,M,F,L,I,” all calls with these call
statuses are purged from the database. (If the registry
entry is missing, the default is assumed.)
Note

PersonalCallbackNoAnswerRingLimit 4

The call status values can optionally be
delimited using a comma, a hyphen, a
semicolon, or a colon. For more information
about call status values, see the Database
Schema Handbook for Cisco Unified Contact
Center Enterprise at https://www.cisco.com/
en/US/products/sw/custcosw/ps1844/prod_
technical_reference_list.html.

If needed, create this registry entry.
The number of times a customer phone rings before
classifying the call as an unanswered. The valid range
is from 2 to 10.

Step 10

In Script Editor, create a routing script that sets up the Personal Callback reservation.

Step 11

Configure the Queue to Agent node.

Voice Gateway and Unified CVP Configuration for a VRU Campaign
For a VRU campaign, you need to configure a dial-peer in the voice gateway. This dial peer is used to instruct
the voice gateway to transfer the call to Unified CVP. It must match the Network VRU label that is configured
on the MR routing client with type 10 Unified CVP network VRU.
In base configuration, this label is preconfigured with default value 66611110000. Follow the steps in this
example.
Procedure

Step 1

Add a dial-peer to match the network VRU label in the outbound routing client.
Example:
dial-peer voice 6661111 voip
description ******To CVP1*****
destination-pattern 6661111T
session protocol sipv2
session target ipv4:10.10.10.10
voice-class codec 1
voice-class sip rel1xx supported "100rel"
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dtmf-relay rtp-nte h245-signal h245-alphanumeric
no vad

Note

Step 2

The call can be transferred to only one Unified CVP; in the above example, the call is transferred
to CVP1.

Configure a dial-peer for the VRU leg. This is the same dial-peer as the inbound call flow whose call is
transferred to Unified CVP.
Example:
dial-peer voice 777111 voip
description Used for VRU leg
service bootstrap
incoming called-number 7771111T
voice-class sip rel1xx disable
dtmf-relay rtp-nte h245-signal h245-alphanumeric
codec g711ulaw
no vad

Step 3

A dialed number pattern needs to be configured on Unified CVP OAMP so that Unified CVP can route the
call to the VXML gateway after it receives the run script request from the router. This dialed pattern is the
same one as the inbound call flow that transfers a call to VRU. If the base configuration has not been changed,
the pattern is 777111*.
Note

It is possible that the procedures in Steps 2 and 3 may have been done already during installation.
For more information, see the Cisco Packaged Contact Center Enterprise Installation and Upgrade
Guide at https://www.cisco.com/en/US/products/ps12586/prod_installation_guides_list.html.

Outbound Option Scripting
Outbound Option uses Packaged CCE scripting configured on the Administrative Workstation to manage
campaigns.
There are two types of scripts:
• Administrative Scripts
• Agent Reservation Routing Scripts
Administrative Scripts for Outbound Option
Outbound Option administrative scripts enable, disable, or throttle campaign skill groups for outbound
campaigns. The scripts can also automatically close out a skill group for a specific campaign. The administrative
scripts can use time or any other conditional factor that the script can access to close a skill group. You can
perform this scripting at the skill group level to provide more flexibility for managing larger campaigns with
multiple skill groups.
Enable a campaign skill group by setting the campaign mode to one of the available modes: Preview, Direct
Preview, Progressive, or Predictive. Schedule an administrative script to run at regular intervals. Disable the
campaign skill group in the administrative script by creating a script node to change the campaign mode to
inbound for that skill group.
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An administrative script controls a campaign skill group. You can only map a campaign skill group to one
campaign at a time. Multiple administrative scripts controlling the same skill group can result in conflicting
campaign mode requests.

Note

Both the Outbound API and administrative scripts can set the dialing mode for a campaign. The value set by
the administrative script takes precedence over the value set by the API.

You can also use administrative scripts to control the percentage of agents that a campaign skill group can
use. A script can also set whether to use a skill group for other campaigns or inbound calls.

Note

To allow the outbound control and percent configured values from Campaign Skill group (set by either the
Configuration Manager Campaign Skill Group tab or the Campaign API) to apply without restarting the router.
If you use an administrative script to set the outbound control and percent variables in operation and if you
want to employ these configured value on the Campaign Skillgroup, set the outbound control and percent
variable to -1 in the administrative script accordingly.

Set Up Administrative Scripts
Use the Script Editor application to create an administrative script for each skill group to set the
OutboundControl variable and the skill group reservation percentage. The Outbound Option Dialer uses the
value of this variable to determine which mode each skill group uses.

Note

• If the OutboundControl variable is not set, the skill group defaults to inbound. See chapter 1, "Outbound
Business Concepts" for detailed information about Outbound Option outbound dialing modes.
• Make sure that the routing client for the translation route labels is Unified CM, which makes the outgoing
call.

Perform the following steps to create the administrative script:
Procedure

Step 1

Open the Script Editor application.

Step 2

Select File > New > Administrative Script.

Step 3

Create an administrative script.
One script can be used to control all Outbound Option skill groups or multiple scripts can control multiple
Outbound Option skill groups. For example, if you want to control skill groups at different times of the day,
you need multiple administrative scripts; however, if you are going to initialize the groups all in the same
way, you need only one script (with additional Set nodes).

Step 4

Set up the script with the following nodes (required): Start, Set Variable, and End.

Outbound Option
52

Outbound Option
Set Up Administrative Scripts

The following diagram displays a simple administrative script where both the OutboundControl variable and
the outbound percentage are set for a skill group. A script in a production call center is typically more complex,
perhaps changing these variables according to time of day or service level.
Figure 7: Sample Administrative Script

Note

Step 5

The Transfer to VRU feature requires an IF node in the administrative script to disable it if the VRU
is not available. Also, to ensure timely responses to VRU outages, set the administrative script to
run every minute.

Set the OutboundControl variable. Setting this variable enables contact center managers to control the agent
mode.
Right-click on the work space and select NEW > Object > Set Variable to open the Set Properties window.
• For Object Type, select a skill group.
• For variable, select OutboundControl.
Set this variable to one of the values listed in the following table.
Table 6: OutboundControl Variable Values

Value String

Description

INBOUND

Agents take inbound calls only. Outbound dialing is disabled for the
skill group.
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Value String

Description

PREDICTIVE_ONLY

Agents in the skill group are dedicated for outbound Predictive calls
only.

PREVIEW_ONLY

Agents in the skill group are dedicated for outbound Preview calls
only.

PROGRESSIVE_ONLY

Agents in the skill group are dedicated for outbound Progressive calls
only.

PREVIEW_DIRECT_ONLY

Agents only place outbound calls and hear ringtones, such as phone
ringing or busy signal.

Note

Step 6

If the administrative script is changed and the SET variable is removed, the value of the
OutboundControl variable is the same as it was the last time the script was executed. However, if
the Central Controller is restarted, the value resets to INBOUND.

Right-click on the work space and select NEW > Object > Set Variable to open the Set Properties window.
• For Object Type, select a skill group.
• For variable, select OutboundControl.

Step 7

Set the OutboundPercent variable in the same administrative script; for example, select the OutboundPercent
variable in the Set Properties window and enter the agent percentage in the Value field. This variable controls
the percentage of agents, which are logged in to a particular skill group, used for outbound dialing. For example,
if 100 agents are logged in to a skill group, and the OutboundPercent variable is set to 50%, 50 agents are
allocated for outbound dialing for this campaign skill group. This setup allows the rest of the agents to be
used for inbound or other active campaigns. The default is 100%.
Note

Step 8

This variable does not allocate specific agents for outbound dialing, just a total percentage. The
default is 100%.

Schedule the script.
a) Select Script > Administrative Manager. An Administrative Manager dialog box appears.
b) Click Add.
c) On the Script tab, select the administrative script.
d) On the Period tab, specify the run frequency of the script. (For example, every minute of every day.)
e) (Optional) Enter a description on the Description tab.
f) Click OK to close the Add Administrative Schedule dialog box.
g) Click OK to close the Administrative Manager.

Sample Administrative Script: ServiceLevelControl
The following figure demonstrates how to control skill group modes based on “Service Level,” which maximizes
the resource utilization in a call center and maintains an acceptable service level at the same time.
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Figure 8: ServiceLevelControl Script

This script divides the day into two parts:
• Peak Traffic Period (8:00 a.m. to 12:00 p.m.): During this period, the OutboundControl variable is set
to INBOUND only, because more agents are required to handle inbound calls.
• Other Periods: During all other time periods, the OutboundControl variable is set according to the
service level in the past half hour. If the skill group service level in the past half-hour period is over 85%,
the OutboundControl variable gets set to PREDICTIVE_ONLY, which maximizes the efficiency of
outbound campaigns. If during any half-hour period the skill group service level drops below 85%, the
OutboundControl variable is switched to PREVIEW_BLENDED, so that the agents in the skill group
can accept inbound calls to improve the service level. When the agents are not in an inbound call,
Outbound Option presents the agents with a Preview outbound call, maximizing the resource utilization
for the call center at the same time.
Add the IF Node
To add the IF node, follow these steps:
Procedure

Step 1

Select ObjectType as Skillgroup.

Step 2

Select the skill group that was created for outbound as the Object.

Step 3

Select ServiceLevelHalf as the variable.
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Routing Scripts for Outbound Option
Two types of routing scripts are described later in this document. One is for Agent Campaign and one is for
VRU Campaign.

Set Up Routing Scripts
Use the Script Editor application to create a reservation script that uses the dialed number for the Outbound
Routing Type and routes through one of the following methods:
• Using a Select node to the previously configured skill group.
• Using Dynamic Route Target by ID in the Skill Group node.
Before beginning this procedure, you must create and configure a skill group. For information about creating
skill groups, see the Cisco Packaged Contact Center Enterprise Administration and Configuration Guide at
https://www.cisco.com/en/US/products/ps12586/tsd_products_support_series_home.html.
The following sections contain diagrams displaying sample routing scripts.
Script for Agent Campaign Without Personal Callback
The following steps and accompanying diagrams provide an example of how to create a script for an agent
campaign without personal callback.
Procedure

Step 1

Using the Dialed Number tool, associate the Outbound Voice dialed numbers with the configured call type.

Step 2

Using the Call Type Manager in Script Editor, associate the MR dialed numbers with the configured call
type and newly created reservation script.
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Figure 9: Sample Script for Agent Campaign Without Personal Callback (Using Select Node)

Figure 10: Sample Script for Agent Campaign Without Personal Callback (Using Dynamic Route Target by ID)

Script for Agent Campaign with Personal Callback
The following steps and accompanying diagram provide an example of how to create a script for an agent
campaign with personal callback.
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Include the following nodes:
• Add a queue-to-agent node.
• Add a Queue to Skill Group Node after the Queue to Agent Node. Use a skill group that handles outbound
calls.
• End the script in a release call node for a successful case; otherwise end the script with the END node.
Procedure

Step 1

Using the Dialed Number tool, associate the Outbound Voice dialed numbers and Personal Callback dialed
numbers with the configured call type.

Step 2

Using the Script Editor Call Type Manager, associate the call type with the newly created reservation script.
Figure 11: Sample Script for Agent Campaign with Personal Callback

Configure Queue to Agent Node
Procedure

Step 1

In Script Editor, double-click the Queue to Agent node.

Step 2

In the Agent Expression column, enter Call.PreferredAgentID.

Step 3

Confirm that the Peripheral column is left blank.

Step 4

Click OK to save the Queue to Agent node.

Step 5

Save and then schedule the script. When scheduling the script, use the call type that is configured for personal
callback.

Outbound Option
58

Outbound Option
Script for VRU Campaign

For more information about script scheduling, see the Cisco Packaged Contact Center Enterprise
Administration and Configuration Guide at https://www.cisco.com/en/US/products/ps12586/tsd_products_
support_series_home.html.

Script for VRU Campaign
The following steps and accompanying diagram provide an example of how to create a script for a VRU
campaign.
Procedure

Step 1

Using the Dialed Number tool, associate the Outbound Voice dialed numbers with the configured call type.

Step 2

Using the Script Editor Call Type Manager, associate the call type with the newly created reservation script.
Figure 12: Sample Script for VRU Campaign
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SIP Dialer Recording Parameters Configuration
When recording is enabled in a campaign, the number of recording files that result can be large. The following
table lists registry settings that you can adjust to regulate the number of recording sessions and the maximum
recording file size.
Registry Setting

Default Setting Description

MaxAllRecordFiles

500,000,000

The maximum recording file size (in bytes) of all
recording files.

MaxMediaTerminationSessions

200

The maximum number of media termination sessions
if recording is enabled in the Campaign configuration.

MaxPurgeRecordFiles

100,000,000

The maximum recording file size (in bytes) when the
total recording file size, MaxAllRecordFiles, is reached.

MaxRecordingSessions

100

The maximum number of recording sessions if
recording is enabled in the Campaign configuration.

Recording files are in the HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\ICM\<customer instance>\Dialer directory.

Note

Only the G.711 codec is supported for recording. To record outbound calls, configure the G.711 on the voice
gateway.

Verification of Dialed Number
Outbound Option places agents in the Reserved state before using them for an outbound call. The dialer uses
the dialed number to route to an agent. The following procedure describes how to verify that this mechanism
works properly.
Verify DN Configuration
When an Outbound Option Dialer is installed in a Unified CCE environment, the dialer uses the dialed number
to make routing requests through the Media Routing (MR) Peripheral Gateway. The following verification
steps assume that you have completed all the applicable configuration and reservation script generation.
Procedure

Step 1

Log in an agent to a skill group participating in an outbound campaign, and make the agent available. (Note
the dialed number, which was configured in the Skill Group Selection tab in the Campaign component.) If a
different dialed number is used for predictive and preview calls, make sure to verify both dialed numbers.

Step 2

Run the Script Editor application and select the Call Tracer utility from the Script > Call Tracer menu.
Select the routing client that is associated with the MR PG and select the Dialed Number.

Step 3

Press Send Call to simulate a route request and note the results. If a label was returned for the agent who was
logged in above, the reservation script is working properly and the dialer can reserve agents through this script.
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Verify Campaign Configuration
As a final step to verify that you configured your Outbound Option campaign correctly, create a small campaign
of one or two entries that dial work phones or your mobile phone.

Campaign Management
To manage your campaigns most efficiently, use multiple query rules instead of using multiple campaigns.

Single Campaign Versus Multiple Campaigns
You might choose to run multiple campaigns because of different calling policies (for example, time rules)
or to run different outbound modes simultaneously.
From the perspective of dialer port allocation, running fewer campaigns with a larger agent pool is more
efficient. Dialer ports are allocated based on the number of agents assigned and the current number of lines
per agent to dial. The more campaigns you have that are active, the more the ports are distributed across the
campaigns, which affects overall efficiency.
Use query rules to break down a campaign into smaller requirements. These rules can be enabled based on
penetration or scheduled times. Campaign reports are available on a query rule level.

Results from Individual Customers
After running a campaign, you can generate a list of customers who were reached, not reached, or have invalid
phone numbers.
Interpret Information from Dialer_Detail Table
The Dialer_Detail table is a single table that contains the customer call results for all campaigns. When you
view the Dialer_Detail table, note that each attempted Outbound Option call is recorded as an entry in the
table. Each entry lists the number called and which numbers are invalid.
For more information, see the appendix on the Dialer Detail Table.

Management of Campaign Manager Database Tables
The Campaign Manager tables, Dialing_List and Personal_Callback_List can grow to be large. If the database
size grows too large, Campaign Manager performance can significantly slow down. To limit the size of the
Outbound Option database, a stored procedure is run daily at midnight to purge records that are no longer
needed.
By default, records are removed from the Personal_Callback_List table when the record's CallStatus is C or
M, and the CallbackDateTime for the record is more than five days old. In the Dialing_List table, records
are removed by default when CallStatusZone1 has a value of C or M, and ImportRuleDate is more than
five days old.
You can change the status and age of the records to be removed by modifying the Campaign Manager registry
values on the Logger machine. The registry settings are located in
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance
name>\LoggerA\BlendedAgent\CurrentVersion in the Outbound Option registry.
• To specify the records to remove from the Personal_Callback_List table, set
PersonalCallbackCallStatusToPurge and PersonalCallbackDaysToPurgeOldRecords.
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Note

PersonalCallbackCallStatusToPurge is not added by default. To change the
call status of the records to remove, create this registry setting manually.

• To specify the records to remove from the Dialing_List table, set DialingListCallStatusToPurge and
DialingListDaysToPurgeOldRecords.

Note

DialingListCallStatusToPurge is not added by default. To change the call status
of the records to remove, create this registry setting manually.

To specify the age of the records to be removed, set PersonalCallbackDaysToPurgeOldRecords or
DialingListDaysToPurgeOldRecords to specify the number of days to keep the record before it is removed.
For the Personal Callback list, this value is the number of days after the personal callback is scheduled
(CallbackDateTime). For the Dialing List, this value is the number of days after the record is imported
(ImportRuleDate). The default is 5. The valid range is 1 to 30. If the value is not set or set to 0, the automated
purge is disabled.
To set the call status of the records to be removed, set PersonalCallbackCallStatusToPurge or
DialingListCallStatusToPurge to a string containing the call status types to apply when purging personal
callback or dialing list records. For example, if the string contains “C,M,F,L,I,” all records with these call
statuses, that are also older than the number of days specified by PersonalCallbackDaysToPurgeOldRecords
or DialingListDaysToPurgeOldRecords, are removed from the database.
You can specify the following call status values:
Value

Description

U

Unknown

F

Fax

I

Invalid Number

O

Operator

L

Not Allocated

X

Agent Not Available

C

Closed

M

Max Calls

Management of Predictive Campaigns
The following sections provide guidelines to follow when working with predictive campaigns.
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Initial Values for Lines per Agent
Determining the initial value for the number of lines per agent is not as simple as inverting the hit rate. If a
campaign has a 20% hit rate, you cannot assume that five lines per agent is the applicable initial value for the
campaign if you are targeting a 3% abandon rate. The opportunity for abandoned calls increases geometrically
as the lines per agent increases; therefore, set the initial value conservatively in the campaign configuration.
If the reports show that the abandon rate is below target and does not come back in line very quickly, modify
the initial value in the campaign configuration to immediately correct the lines per agent being dialed.
End-of-Day Calculation for Abandon Rate
It is not unusual for a campaign to be over the abandon rate target for any given 30 minute period. The dialer
examines the end-of-day rate when managing the abandon rate. If the overall abandon rate is over target for
the day, the system targets a lower abandon rate for remaining calls until the average abandon rate falls into
line. This end-of-day calculation cannot work until after the campaign has been running for one hour. Small
sample sizes due to short campaigns or campaigns with fewer agents might not give the dialer enough time
to recover from an initial value that is too high.
Similarly, if the campaign is significantly under the target abandon rate, it might begin dialing more frequently
with an abandon rate over target for a while to compensate in the abandon rate.
Transfer of Answering Machine Detection Calls to Agents
When enabling the Transfer AMD (Answering Machine Detection) to agent option for an agent campaign or
enabling the Transfer AMD to IVR option for an IVR campaign, consider the increase in calls to the target
resources (agents or IVR) when determining the initial value. If the expectation is that the AMD rate and the
live voice rate are over 50%, perhaps start out with an initial value of 1.1 or even one line per agent to stay
under a 3% abandon rate.

Management of Agent Idle Time
One of the key reporting metrics for administrators managing campaigns is the amount of time agents spend
idle between calls.
There are many possible reasons for longer idle times, such as a combination of one or more of the following:
• A dialing list with a low hit rate. The solution is to create an improved list.
• A small agent pool results in fewer calls, resulting in slower adjustments. One solution is to add more
agents to the pool.
• Shorter average handle times means agents become available more frequently. A shorter handle time
means that the agent idle time percentage will climb.
• Not enough dialer ports deployed or too many agents. Deploy more ports or use fewer agents.
• A large number of retry attempts at the beginning of a day when running with append imports resulting
in lower hit rates. Prioritize pending over retries.
• Modifying the maximum number of attempts up or down in an active campaign. This activity can interrupt
the Campaign Manager’s processing of dialer requests for records, as mentioned earlier in this chapter.
One solution is to perform the activity during off hours.
• Running out of records to dial. Import new records.
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Sources of Higher Idle Times in Reports
The following Outbound Option reports provide information regarding sources of higher idle times:
• Campaign Consolidated Reports: These reports provide a very useful overview of a campaign by
combining campaign and agent skill group statistics into a single report. They provide average idle time,
campaign hit rate, the number of agents working on the campaign, as well as their Average Handle Time
per call. Low hit rates and low average handle times result in more work for the dialer to keep those
agents busy.
• Dialer Capacity Reports: These reports show how busy the dialers are and how much time was spent at
full capacity when the dialer was out of ports. They also provide the average reservation call time as well
as the average time each dialer port spent contacting customers.
Dialer Saturation
If both Dialers have relatively low idle times and high all ports busy times, then it is likely the Dialers have
been oversubscribed. The combination of number of agents, Dialing List hit rate, and average handle time are
likely more than the deployed number of ports the Dialer can handle.
To solve this problem, perform one of the following actions:
• Reduce the number of agents working on the campaign.
• Add more Dialer ports to the solution.
Few Available Records
Call Summary Count reports show how many records in the aggregate campaign dialing lists have been closed
and how many are still available to dial.

Reports
This section provides an overview of the Outbound Option reports available in the Cisco Unified Intelligence
Center.

Outbound Option Reports
This section describes the Outbound Option reports, created using the Unified Intelligence Center.
• Outbound Historical Reports Bundle, on page 65
• Outbound Realtime Reports Bundle, on page 66
• Agent Reports, on page 66
• Campaign and Dialer Reports, on page 67
• Skill Group Reports, on page 69
• Import Rule Reports, on page 69
Additionally, sample custom report templates are available from the Cisco Developer Network
(https://developer.cisco.com/web/ccr/documentation.)
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Note

Call Type reporting can be used on Outbound Option reservation calls and transfer to VRU calls. Call Type
reporting is not applicable for outbound customer calls because a routing script is not used.

Outbound Historical Reports Bundle
The Outbound Options Historical reports receive data from the historical data source. Reports are populated
with interval data that has a default refresh rate of 15 minutes.
Half-hour/Daily: Provides statistics for each half-hour period. Many of the half-hour reports are also available
in a daily report format.
The Outbound Historical bundle contains the following reports:
Report

Description

Attempts per Campaign Daily

Shows the status (summary and percentage) of each
campaign for the selected time period and the
breakdown of attempts (in percentage) of each
campaign for the selected time period.

Campaign Consolidated Daily

Shows the daily activity and performance of the
selected campaigns and their skill groups for the
selected time period and provides analysis of the
actual customer calls (outbound calls which reached
live voice, inbound calls, or calls transferred to the
campaign's skill group) for the selected campaigns
and their skill groups for the selected time period.

Campaign Consolidated Half Hour

Shows the list of Consolidated Calls and Agent
Statistics per Campaign by Half Hour and Breakdown
of completed calls.

Campaign Half Hour Summary

Shows the status for all campaigns for the selected
time period, the status (summary and percentage) of
each campaign for the selected time period and the
breakdown of attempts (in percentage) of each
campaign for the selected time period.

Dialer Call Result Summary Half Hour

Shows the status of each dialer for the selected time
period.

Dialer Capacity Daily
Dialer Capacity Half Hour
Import Rule

Shows the status of imported records for the selected
time period.

Query Rule Within Campaign Daily

Shows the breakdown of attempts (in percentage) of
each campaign for the selected time period and the
status (summary and percentage) of each campaign
for the selected time period.
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Report

Description

Query Rule Within Campaign Half Hour

Shows the breakdown of attempts (in percentage) of
each campaign for the selected time period, the status
(summary and percentage) of each campaign for the
selected time period and the status for each Query rule
within a campaign for the selected time interval.

Outbound Realtime Reports Bundle
The Outbound Option Real Time reports display current information about a system entity; for example, the
number of tasks an agent is currently working on or the number of agents currently logged in to a skill group.
By default, the reports automatically query the Admin Workstation database on the distributor every 15
seconds. The data is written to the database by the Router almost every 10 seconds.
The Outbound Real Time Reports Bundle contains the following reports:
Report

Description

Call Summary Count per Campaign Real Time

Shows the status of each query rule within a campaign,
status of all campaign records, and the currently valid
campaign dialing times.

Dialer Real Time

Shows the status of each dialer, including the number
of contacts dialed today and the result of each attempt.

Import Status Real Time

Shows the status of Outbound Option import records.

Query Rule Within Campaign Real Time

Shows the status of all campaign records, dialing
times, and query rule within a campaign.

Agent Reports
In addition to the reports contained in the Outbound Reports bundles, other Agent reports also provide
information about Outbound activities:
Report

Outbound Option Fields

Agent Queue Real-Time

The Direction field indicates the direction of the call
that the agent is currently working on including Other
Out/Outbound Direct Preview, Outbound Reserve,
Outbound Preview, or Outbound
Predictive/Progressive.

Agent Real-Time
Agent Skill Group Real-Time
Agent Team Real-Time

The Destination field indicates the type of outbound
task on which the agent is currently working.
Agent Team State Counts

The Active Out field shows the number of agents
currently working on outbound tasks.

Agent State Real Time Graph

For agents handling Outbound Option calls, the Hold
state indicates that the agent has been reserved for a
call. The Outbound Dialer puts the agent on hold while
connecting the call.
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Interpreting agent data for Outbound Option tasks, requires understanding how Outbound Option reserves
agents, reports calls that are connected to agents, and handles calls that are dropped by customers before the
calls are connected.
The Outbound Option Dialer assigns and connects calls differently than regular contact center enterprise
routing. Report data for agents handling Outbound Option calls therefore differs from data for agents handling
typical voice calls and multichannel tasks.
When the Outbound Dialer calls a customer, it reserves the agent to handle the call. The Dialer places a
reservation call to the agent and changes the agent's state to Hold. This reservation call is reported as a Direct
In call to the agent.
For typical calls, the agent is placed into Reserved state when the contact center reserves the agent to handle
a call. For Outbound Option calls, reports show the agent in Hold state when reserved for a call and the time
that agent spends reserved is reported as Hold Time.
When the customer answers the call, the Outbound Option Dialer transfers the call to an agent. The call is
now reported as a Transfer In call to the agent. When the customer call is transferred to the agent, the Dialer
drops the reservation call and classifies it as Abandon on Hold.
The abandoned call wait time, set in the Campaign Configuration screen, determines how calls are reported
if the caller hangs up. Calls are counted in the Customer Abandon field in both Real Time and Historical
campaign query templates only if the customer hangs up before the abandoned call wait time is reached.
For agent reporting per campaign, Outbound Option provides reports that accurately represent the Outbound
Option agent activity for a contact center, including information grouped by skill group.
The following list describes the data that are presented in the agent reports.
• A real-time table that shows Outbound Option agent activity that is related to Outbound Option calls.
• A historical table that shows agent daily performance for Outbound Option predictive calls, by skill
group.
• A historical table that shows agent daily performance for Outbound Option preview calls, by skill group.
• A historical table that shows agent daily performance for Outbound Option reservation calls, by skill
group.
Campaign and Dialer Reports
Outbound Option provides a campaign report template that describes the effectiveness of a campaign and the
dialer. This list can be used for Agent and VRU campaigns.
Observe the following guidelines when using the campaign reports:
• Campaign Real Time reports describe how many records are left in the campaign dialing list.
• Both Campaign and Dialer Half Hour reports provide the call result counts.

Note

Campaign Real Time reports capture call results since the last Campaign Manager restart only. If the Campaign
Manager restarts, data collected before the restart is lost.
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Note

When the active Campaign Manager fails over, partial campaign interval reports are generated for the relevant
interval based on the data that was available after failover. Some of the campaign statistics collected prior to
failover will be missing.
The campaign interval tables used in Reporting are impacted due to this scenario.

The following list describes the data that is presented in the campaign reports.
• A summary of call results for query rules within a campaign since the beginning of the day.
• A summary of call results for a campaign since the beginning of the day. It includes a summary of all
query rules within the campaign.
• A view of what is configured for valid campaign calling times for zone1 and zone2 for selected campaigns.
The times are relative to the customer’s time zone.
• A view of what is configured for valid campaign calling times for zone1 and zone2 for selected campaign
query rules. The zone times are relative to the customer’s time zone. The query rule start and stop times
are relative to the Central Controller time.
• How many records for selected query rules have been dialed to completion, and how many records
remain.
• How many records for selected campaigns have been dialed to completion, and how many records remain.
• A summary of call results for selected campaign query rules for selected half-hour intervals.
• A summary of call results for all query rules for selected campaigns for selected half-hour intervals.
• A historical table by half-hour/daily report that shows the status (summary and percentage) of each
campaign for the selected time period.
• A historical table by breakdown of attempts (in percentage) of each campaign for the selected time period.
• A historical table by half-hour/daily report that shows the status (summary and percentage) per query
rule of each campaign for the selected time period.
• A historical table by breakdown of attempts (in percentage) per query rule of each campaign for the
selected time period.
• A summary half-hour/daily report that shows activity and performance of the selected campaigns and
their skill group for the selected time period, including abandon rate, hit rate, and agent idle times.
• A historical table by breakdown of actual customer calls (outbound calls which reached live voice,
inbound calls, or calls transferred to the campaign skill group) for the selected campaigns and their skill
groups for the selected time period.

Dialer Reports
The Outbound Option Dialer reports provide information about the dialer. These reports include information
about performance andresource usage. The templates also enable you to determine whether you need more
dialer ports to support more outbound calls.
The following list describes the data presented in the Outbound Option Dialer reports:
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• A real-time table that shows contact, busy, voice, answering machine, and special information tone (SIT)
detection for each dialer. A SIT consists of three rising tones indicating a call has failed.
• An historical table that records contact, busy, voice, answering machine, and SIT Tone detection for
each dialer by half-hour intervals.
• Displays information about the amount of time the dialer was idle or had all ports busy.
• Displays Dialer status on a port-by-port basis used for troubleshooting. If this report does not display
any records, then the data feed is disabled by default. It is only enabled for troubleshooting purposes.
Skill Group Reports
For skill group reporting per campaign, Outbound Option provides reports that represent the skill group activity
for a contact center.
The following list describes the data presented in the skill group reports:
• A real-time table that shows all skill groups and their associated Outbound Option status.
• A historical table that records Outbound Option counts for the agent states signed on, handle, talk, and
hold by half-hour intervals.
Import Rule Reports
Outbound Option reports also enable you to view the success of record imports. Using the Import Rule
templates, you can monitor whether records are being added successfully (good records) or are failing (bad
records), and how long it takes to import the records.
The same import rule reports are used for Do Not Call and Contact List imports. The reports display a historical
view of when the imports were done, the number of records imported, and the number of records that were
considered invalid because of length constraints or improper formatting.
For contact list imports, the reports also provide insight into the number of contacts that were assigned with
the default time zone information for the campaign, as well as the number of contacts that were imported into
the dialing list after the query rule and format validation was performed.
The following information is available in the Import Rule reports:
• Number of successful, unsuccessful, and total records imported by time range
• Current import status
• A real-time table that shows the number of successful, unsuccessful, and total records imported or to be
imported.
• A historical table that shows the number of successful, unsuccessful, and total records imported by time
range. The Total Records column indicates the total number of records available in the import file.

Note

Import Rule reporting data is not populated for Outbound API-based imports. However, you can get this data
directly from the API.
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